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Adobe Acrobat Reader 5.0 
 
Finding Words 
 
You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields. 

 
To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 
2. Enter the text to find in the text box. 
3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted. 
Match Case finds only words that contain exactly the same capitalization you enter in 
the box. 
Find Backwards starts the search from the current page and goes backwards through 
the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 
       To find the next occurrence of the word:  
        Do one of the following: 
        Choose Edit > Find Again  
        Reopen the find dialog box, and click Find Again.  (The word must already be in the         
Find text box.) 
 
Copying and pasting text and graphics to another application 
 
You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.   

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted. 

 
To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 
       To select a line of text, select the first letter of the sentence or phrase and drag to the last 
letter.   
       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or 
Option (Mac OS) as you drag across the width of the document.  
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       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or 
Option+Command (Mac OS) as you drag the length of the document. 
        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the 
text on the current page is selected.  In Continuous or Continuous – facing mode, most of the 
text in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.   
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.   

2. Choose Edit > Copy to copy the selected text to the clipboard. 
3. To view the text, choose Window > Show Clipboard 
In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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[Note: The Board did not meet in1 

closed session Tuesday, April 15, 2003.]2 

3 

4 

CLERK VARONA-LUKENS: THE MEETING OF THE BOARD OF SUPERVISORS5 

FOR APRIL 12TH, 2003, [Date error noted but retained for6 

accuracy.] WILL PLEASE COME TO ORDER. THERE IS A QUORUM7 

PRESENT. THE FIRST ORDER OF BUSINESS IS THE SELECTION OF A8 

CHAIR PRO TEM TO PRESIDE OVER TODAY'S MEETING.9 

10 

SUP. YAROSLAVSKY: MOVE MOLINA.11 

12 

SUP. ANTONOVICH: SECOND.13 

14 

CLERK VARONA-LUKENS: IT'S BEEN MOVED AND SECONDED THAT15 

SUPERVISOR MOLINA SERVE AS THE CHAIR PRO TEM, SUPERVISOR16 

MOLINA, PLEASE ASSUME THE CHAIR.17 

18 

SUP. MOLINA: ALL RIGHT, THERE'S NO OBJECTION TO THAT, SO19 

ORDERED. WE'RE GOING TO BEGIN BY STARTING WITH OUR INVOCATION20 

AND PLEDGE. IF WE WOULD ALL STAND, WE ARE GOING TO BE LED IN21 

OUR INVOCATION THIS MORNING BY RABBI RICHARD FLOM, AND OUR22 

PLEDGE THIS MORNING WILL BE LED BY JAMES S. ROSA.23 

24 
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RABBI RICHARD A. FLOM: THANK YOU, GOOD MORNING EVERYONE, IT'S1 

A GREAT HONOR AND PRIVILEGE TO BE WITH YOU THIS MORNING, I2 

WISH PARTICULARLY TO THINK SUPERVISOR ANTONOVICH'S OFFICE FOR3 

THE KIND INVITATION TO APPEAR HERE TODAY. THROUGHOUT THE WORLD4 

JEWS WILL TOMORROW EVENING BEGIN THE OBSERVANCE OF PASSOVER,5 

THE FESTIVAL OF FREEDOM. I THINK IT WORTH NOTING THAT EVERY6 

TIME WE IN THIS COUNTY AND STATE AND COUNTRY HOLD AN ELECTION,7 

IT IS ALSO A FESTIVAL OF FREEDOM. EVERY TIME THAT A CITIZEN8 

STANDS UP TO SPEAK TO POWER IN THIS CHAMBER OR IN ANY OF THE9 

THOUSANDS LIKE IT, LARGE AND SMALL THROUGHOUT AMERICA, IT IS10 

ALSO A FESTIVAL OF FREEDOM. WE ARE INDEED GREATLY BLESSED.11 

THIS GREAT COUNTRY OF OURS AND THIS GREAT COUNTY OF OURS IS12 

ALSO BLESSED WITH THE PRESENCE WITHIN ITS BORDERS OF PEOPLE13 

REPRESENTING EVERY LANGUAGE, EVERY NATION, AND EVERY RELIGION.14 

IT IS INDEED A MICROCOSM OF PLANET EARTH. THE FACTS THAT WE15 

ALL MANAGE TO GET ALONG WHILE DISAGREEING THAT WE ACCOMPLISH16 

REGIME CHANGE THROUGH BALLOTS AND NOT BULLETS, AND THAT17 

DISSENTING SPEECH IS MET WITH MORE SPEECH, AND NOT WITH POISON18 

GAS OR TORTURE CHAMBERS SPEAK WELL OF OUR SOCIETY. WHILE I19 

DARE SAY THAT NONE OF YOU HERE NOR ANY OF US IN THIS COUNTY20 

CAN TAKE SPECIAL CREDIT FOR THESE FACTS, NEVERTHELESS, AS OUR21 

ELECTED LEADERS, YOU HAVE THE AWESOME RESPONSIBILITY OF22 

MAINTAINING THE TRANQUILITY AND SECURITY OF OUR LITTLE CORNER23 

OF THE GLOBE. LIFE CERTAINLY WAS SIMPLER WHEN YOU DID NOT HAVE24 

TO CONCERN YOURSELVES WITH DEFENDING US FROM UNIMAGINABLE25 
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TERROR. DESPITE YOUR POWER AND PRESTIGE, I DO NOT ENVY YOU,1 

BUT I DO OFFER THE FOLLOWING PRAYER FOR YOU AND FOR THE PEOPLE2 

YOU REPRESENT. <SPEAKS IN HEBREW> OUR GOD AND GOD OF OUR3 

ANCESTORS, WE PRAY THAT YOU CONTINUE TO BLESS US WITH FREEDOM,4 

PEACE, AND PROSPERITY. WE PRAY THAT THESE LEADERS WHO STAND5 

BEFORE YOU, THOSE WHOM WE HAVE ENTRUSTED WITH SO MUCH6 

AUTHORITY BE CONSTANTLY GUIDED BY THE INSIGHTS OF YOUR HOLY7 

WORD. MAY THEY BE AN INFLUENCE FOR GOOD, MAY THEY EVER PURSUE8 

THE JUSTICE THAT YOU DEMAND AND TO WHICH WE ARE ENTITLED AS9 

HUMAN BEINGS CREATED IN YOUR IMAGE. MAY THEIR LEADERSHIP NOT10 

FALTER DESPITE THE TRAVAILS WE AND THEY FACE. AND WE PRAY THAT11 

YOU WILL CONTINUE TO ENDOW THE LEADERS AND THE PEOPLE OF THIS12 

GREAT COUNTY OF THE ANGELS WITH THE WISDOM AND THE HUMILITY TO13 

CONTINUE ALWAYS AS A WORKING MODEL OF THE POTENTIAL FOR UNITY14 

WITHIN DIVERSITY AND LET US ALL SAY AMEN.15 

16 

JAMES S. ROSA: LADIES AND GENTLEMEN, IF YOU'D PLEASE FACE THE17 

FLAG, COME TO ATTENTION, PLACE YOUR RIGHT HAND OVER YOUR HEART18 

AND FOLLOW ME IN RECITING THE PLEDGE OF ALLEGIANCE OF THE19 

UNITED STATES. [ PLEDGE OF ALLEGIANCE ]20 

21 

SUP. MOLINA: MR. ANTONOVICH?22 

23 

SUP. ANTONOVICH: WELL IT'S A PLEASURE TO WELCOME THE RABBI24 

HERE TODAY FROM BEAUTIFUL DOWNTOWN BURBANK, AND THE RABBI HAS25 
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AN INTERESTING CAREER AFTER GRADUATING FROM THE UNIVERSITY OF1 

PITTSBURGH AND BECOMING A LAWYER AND THEN SWITCHING CAREERS TO2 

GO INTO THE CLERGY, WHERE HE ATTENDED THE UNIVERSITY OF3 

JUDAISM AND WAS ORDAINED IN THE YEAR 2000, AND THEN PERFORMED4 

A TWO-YEAR SERVICE IN MASSACHUSETTS AND THEN SACRIFICED TO5 

GIVE UP ALL THAT COLD TO COME TO SUNNY CALIFORNIA TO LEAD THE6 

FLOCK HERE. AND HE LIVES IN BURBANK, SO WE HAVE THE BEAUTIFUL7 

MOUNTAINS THAT HE'S ABLE TO HIKE IN, WHICH HE ENJOYS HIKING IN8 

AND HE HAS A WIFE AND A SON, AND SO WE WELCOME RABBI TO LOS9 

ANGELES COUNTY ONCE AGAIN AND WE'RE GLAD, WE HOPE YOU WILL10 

STAY HERE THIS TIME AND NOT RETREAT BACK TO THE EAST COAST,11 

BUT THANK YOU VERY MUCH AND HAPPY HOLIDAYS AND GOD BLESS.12 

13 

RABBI RICHARD A. FLOM: THANK YOU. FROM YOUR MOUTH TO GOD'S14 

EARS. [ APPLAUSE ]15 

16 

SUP. MOLINA: THANK YOU, RABBI FLOM. ON BEHALF OF SUPERVISOR17 

KNABE, I WOULD LIKE TO MAKE A PRESENTATION, A CERTIFICATE OF18 

APPRECIATION TO JAMES S. ROSA, MR. ROSA IS COMMANDER OF THE19 

FOURTH DISTRICT VETERANS OF FOREIGN WARS. HE IS CURRENTLY20 

SERVING AS LIEUTENANT COLONEL OF THE MILITARY ENTRANCE21 

PROCESSING STATION FOR THE UNITED STATES AIR FORCE. HE SAW22 

BATTLE IN THE PERSIAN GULF AND HIS EXTRAORDINARY NUMBER OF23 

DECORATIONS, INCLUDE TWO MERITORIOUS SERVICE MEDALS WITH OAK24 

LEAF CLUSTERS, A JOINT SERVICE COMMENDATION MEDAL, SEVERAL25 
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PRESTIGIOUS AIR FORCE COMMENDATION MEDALS, A SOUTHWEST ASIA1 

SERVICE MEDAL AMONG THE MANY DECORATIONS THAT HE HAS RECEIVED.2 

MR. ROSA IS MARRIED WITH TWO CHILDREN AND HE'S RESIDED IN THE3 

FOURTH DISTRICT FOR THE LAST SEVEN YEARS. THANK YOU SO MUCH4 

FOR LEADING US IN OUR PLEDGE OF ALLEGIANCE THIS MORNING. [5 

APPLAUSE ]6 

7 

SUP. MOLINA: WITH THAT, I'M GOING TO ASK OUR EXECUTIVE OFFICER8 

IF YOU WOULD PLEASE CALL THE AGENDA.9 

10 

CLERK VARONA-LUKENS: THANK YOU, MADAM CHAIR, MEMBERS OF THE11 

BOARD. WE'LL BEGIN ON PAGE 3. AGENDA FOR THE MEETING OF THE12 

COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D.13 

14 

SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY15 

SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.16 

17 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE HOUSING18 

AUTHORITY, ITEM 1-H.19 

20 

SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY21 

SUPERVISOR ANTONOVICH, IF THERE'S NO OBJECTION, SO ORDERED.22 

23 

CLERK VARONA-LUKENS: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 13,24 

I HAVE THE FOLLOWING REQUEST. ON ITEM NUMBER 12, HOLD FOR25 
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SUPERVISOR MOLINA AND SUPERVISOR ANTONOVICH IS REQUESTING A1 

ONE-WEEK CONTINUANCE.2 

3 

SUP. MOLINA: WHY DON'T WE HOLD THAT ITEM FOR AN AMENDMENT. ON4 

THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY5 

SUPERVISOR ANTONOVICH, IF THERE'S NO OBJECTION, SO ORDERED.6 

7 

CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 14 THROUGH8 

19. ON ITEM NUMBER 18, AS NOTED ON THE GREEN SHEET, THE CHIEF9 

ADMINISTRATIVE OFFICER REQUESTS A CONTINUANCE OF ONE WEEK.10 

11 

SUP. MOLINA: ALL RIGHT, WITH THE EXCEPTION OF NUMBER 18, IT'S12 

MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR13 

ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED.14 

15 

CLERK VARONA-LUKENS: BEACHES AND HARBORS. ON ITEM NUMBER 20,16 

THE DIRECTOR REQUESTS A TWO-WEEK CONTINUANCE.17 

18 

SUP. MOLINA: ALL RIGHT. THAT ITEM IS CONTINUED.19 

20 

CLERK VARONA-LUKENS: BUSINESS LICENSE COMMISSION. AS NOTED ON21 

THE GREEN SHEET, THERE ARE REVISIONS AND THE ITEM IS BEFORE22 

YOU. SUPERVISOR BURKE IS WITHDRAWING HER REQUEST TO CONTINUE23 

THE ITEM.24 

25 
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SUP. MOLINA: ALL RIGHT.1 

2 

SUP. YAROSLAVSKY: WHICH ITEM IS THAT?3 

4 

CLERK VARONA-LUKENS: 215 

6 

SUP. MOLINA: THAT'S ITEM 21 AS AMENDED ON THE GREEN SHEET.7 

8 

SUP. YAROSLAVSKY: WHAT WAS THE ITEM BEFORE THAT, THAT WAS9 

CONTINUED FOR TWO WEEKS?10 

11 

SUP. MOLINA: THE ITEM PRIOR TO THAT? 20. IT WAS CONTINUED BY12 

THE DIRECTOR FOR TWO WEEKS.13 

14 

SUP. YAROSLAVSKY: OKAY.15 

16 

SUP. MOLINA: ON THIS ITEM, AS AMENDED, IS THERE ANY OBJECTION?17 

MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR18 

YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.19 

20 

CLERK VARONA-LUKENS: CHIEF INFORMATION OFFICER, ITEM 22.21 

SUPERVISOR MOLINA REQUESTS THAT THE ITEM BE HELD AND THE CHIEF22 

INFORMATION OFFICER IS REQUESTING A TWO-WEEK CONTINUANCE.23 

24 
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SUP. MOLINA: WELL, THEN, WHY DON'T WE GO AHEAD AND CONTINUE IT1 

FOR TWO WEEKS.2 

3 

CLERK VARONA-LUKENS: OKAY. COUNTY COUNSEL, ITEM 23.4 

5 

SUP. MOLINA: ALL RIGHT. MOVED BY SUPERVISOR ANTONOVICH,6 

SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION,7 

SO ORDERED.8 

9 

CLERK VARONA-LUKENS: DISTRICT ATTORNEY. ON ITEM 24, RICHARD10 

RUBOLIA REQUESTS -- OH, ROBINSON.11 

12 

SUP. MOLINA: ALL RIGHT. THAT ITEM WILL BE HELD, SIR, FOR A13 

SPEAKER. THANK YOU.14 

15 

CLERK VARONA-LUKENS: OKAY. FIRE DEPARTMENT, ITEM 25.16 

17 

SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY18 

SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED ON19 

THAT ITEM.20 

21 

CLERK VARONA-LUKENS: HEALTH SERVICES, ITEMS 26 THROUGH 28. ON22 

ITEM NUMBER 28, SUPERVISOR ANTONOVICH REQUESTS THAT THE ITEM23 

BE HELD AND THE DIRECTOR IS REQUESTING A TWO-WEEK CONTINUANCE.24 

25 
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SUP. MOLINA: WOULD YOU LIKE TO CONTINUE IT? YOUR AGREEMENT IN1 

CONTINUANCE? OKAY. WITH ITEM NUMBER 28, WILL BE CONTINUED FOR2 

TWO WEEKS. AND ITEM 26 AND 27, MOVED BY SUPERVISOR ANTONOVICH,3 

SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION,4 

SO ORDERED.5 

6 

CLERK VARONA-LUKENS: PARKS AND RECREATION, ITEMS 29 THROUGH7 

31.8 

9 

SUP. MOLINA: OKAY. MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY10 

SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.11 

12 

CLERK VARONA-LUKENS: PUBLIC WORKS, ITEMS 32 THROUGH 52. ON13 

ITEMS NUMBER 32 AND 33, WE'LL CONTINUE ONE WEEK FOR FOUR14 

VOTES. THE REMAINDER ARE BEFORE YOU.15 

16 

SUP. MOLINA: ON THE REMAINDER, MOVED BY SUPERVISOR17 

YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO18 

OBJECTION, SO ORDERED.19 

20 

CLERK VARONA-LUKENS: ON PAGE 19, SHERIFF, ITEMS 53 THROUGH 56.21 

ON ITEM NUMBER 53, IT'S A 4-VOTE, CONTINUE IT FOR ONE WEEK.22 

23 

SUP. MOLINA: SO ORDERED.24 

25 
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CLERK VARONA-LUKENS: ON ITEM 54, IT ALSO INCLUDES THE C.I.O.'S1 

RECOMMENDATIONS FOR MODIFICATIONS WHICH ARE INCLUDED IN THE2 

SHERIFF'S BOARD LETTER. ON ITEM NUMBER 55, THE SHERIFF3 

REQUESTS A TWO-WEEK CONTINUANCE AND THE REMAINDER, WITH THE4 

MODIFICATIONS TO 54, ARE BEFORE YOU.5 

6 

SUP. MOLINA: ALL RIGHT. SO WE ARE CONTINUING 53, WE ARE7 

CONTINUING 55, SO BEFORE US IS ITEM 54 AND 56. MOVED BY8 

SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF9 

THERE'S NO OBJECTION, SO ORDERED.10 

11 

CLERK VARONA-LUKENS: TREASURER AND TAX COLLECTOR, ITEM 57.12 

13 

SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY14 

SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.15 

16 

CLERK VARONA-LUKENS: MISCELLANEOUS COMMUNICATIONS, ITEMS 5817 

AND 59. ON ITEM 59, THE COUNTY COUNSEL REQUESTS A ONE-WEEK18 

CONTINUANCE.19 

20 

SUP. MOLINA: ALL RIGHT. ON ITEM NUMBER 58, MOVED BY SUPERVISOR21 

ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO22 

OBJECTION, SO ORDERED.23 

24 
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CLERK VARONA-LUKENS: ORDINANCE FOR INTRODUCTION, ON ITEM 60,1 

AS NOTED ON THE GREEN SHEET, THE CHIEF ADMINISTRATIVE OFFICER,2 

REQUESTS THAT THE ITEM BE CONTINUED ONE WEEK.3 

4 

SUP. MOLINA: ALL RIGHT. THAT ITEM WILL BE CONTINUED.5 

6 

CLERK VARONA-LUKENS: ORDINANCES FOR ADOPTION, 61 AND 62. ON7 

ITEM 61, SUPERVISOR KNABE REQUESTS A THREE-WEEK CONTINUANCE.8 

9 

SUP. MOLINA: ALL RIGHT, SO WE HAVE ITEM 62 BEFORE US. MOVED BY10 

SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF11 

THERE'S NO OBJECTION, SO ORDERED, AND WE'LL CONTINUE ITEM12 

NUMBER 61.13 

14 

CLERK VARONA-LUKENS: SEPARATE MATTERS, 63 THROUGH 66, AND I'LL15 

READ THESE INTO THE RECORD. 63 IS THE TREASURER AND TAX16 

COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE17 

ISSUANCE AND SALE OF EL MONTE UNION HIGH SCHOOL DISTRICT18 

GENERAL OBLIGATION BONDS, ELECTION 2002 SERIES A, IN AGGREGATE19 

PRINCIPAL AMOUNT NOT TO EXCEED $25 MILLION. THAT ITEM IS20 

BEFORE YOU.21 

22 

SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY23 

SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.24 

25 
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CLERK VARONA-LUKENS: 64, TREASURER AND TAX COLLECTOR'S1 

RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE2 

AND SALE OF GLENDALE COMMUNITY COLLEGE DISTRICT, GENERAL3 

OBLIGATION BONDS ELECTION 2002 SERIES B AND C, IN AGGREGATE4 

PRINCIPAL AMOUNT NOT TO EXCEED $17,500,000. THAT ITEM IS5 

BEFORE YOU.6 

7 

SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY8 

SUPERVISOR ANTONOVICH, IF THERE'S NO OBJECTION, SO ORDERED.9 

10 

CLERK VARONA-LUKENS: 65, TREASURER AND TAX COLLECTOR'S11 

RECOMMENDATION TO ADOPT A RESOLUTION AUTHORIZING THE ISSUANCE12 

AND SALE OF PASADENA UNIFIED SCHOOL DISTRICT GENERAL13 

OBLIGATION BONDS, ELECTION 1997 SERIES D, IN AGGREGATE14 

PRINCIPAL AMOUNT NOT TO EXCEED $70 MILLION. THAT ITEM IS15 

BEFORE YOU.16 

17 

SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY18 

SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED.19 

20 

CLERK VARONA-LUKENS: 66, TREASURER AND TAX COLLECTOR'S21 

RECOMMENDATION TO ADOPT RESOLUTION PROVIDING FOR THE ISSUANCE22 

OF SANTA MONICA MALIBU UNIFIED SCHOOL DISTRICT, 2003, 2004,23 

TAX AND REVENUE ANTICIPATION NOTES, IN AGGREGATE PRINCIPAL24 

AMOUNT NOT TO EXCEED $5 MILLION.25 
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1 

SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY2 

SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED.3 

4 

CLERK VARONA-LUKENS: BUDGET MATTER. ON ITEM 67, WE'LL HOLD5 

THAT FOR THE CHIEF ADMINISTRATIVE OFFICER. MISCELLANEOUS6 

ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE7 

CHIEF ADMINISTRATIVE OFFICER, WHICH WERE POSTED MORE THAN 728 

HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN9 

SUPPLEMENTAL AGENDA. ON ITEM 68-A, SUPERVISOR MOLINA REQUESTS10 

A ONE-WEEK CONTINUANCE. AND ON ITEM 68-B, SUPERVISOR11 

YAROSLAVSKY REQUESTS A ONE-WEEK CONTINUANCE.12 

13 

CLERK VARONA-LUKENS: IF THERE'S NO OBJECTION, THOSE ITEMS WILL14 

BE CONTINUED.15 

16 

CLERK VARONA-LUKENS: THAT COMPLETES --17 

18 

C.A.O. JANSSEN: MADAM, MADAM CHAIR, ON ITEM 22, WHICH WAS THE19 

C.I.O. ITEM ON BUSINESS CONTINUITY, HE DOES NOT WANT A TWO-20 

WEEK CONTINUANCE. I BELIEVE YOU WERE GOING TO HOLD THE ITEM.21 

22 

SUP. MOLINA: THAT'LL BE FINE. WHY DON'T WE HOLD THE ITEM. I'M23 

JUST LOOKING FOR SOME INFORMATION.24 

25 
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SUP. ANTONOVICH: AND MOVE FOR RECONSIDERATION.1 

2 

SUP. MOLINA: MOVED FOR RECONSIDERATION BY SUPERVISOR3 

ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO4 

OBJECTION, THEN THAT ITEM'S BEEN RECONSIDERED AND BEFORE US,5 

SO I'LL HOLD IT JUST TO GET SOME INFORMATION.6 

7 

CLERK VARONA-LUKENS: SO THAT COMPLETES THE READING OF THE8 

AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH9 

SUPERVISORIAL DISTRICT NUMBER 1.10 

11 

SUP. MOLINA: ALL RIGHT. WE HAVE PRESENTATIONS. I'D LIKE TO12 

BEGIN BY, ON BEHALF OF THE CHAIR, YVONNE BURKE, MAKING A13 

PRESENTATION TO OUR EMPLOYEE OF THE YEAR -- OF THE MONTH. ALL14 

RIGHT, I'M GOING TO STEP UP TO THE FRONT, BUT I'M NOT SURE, DO15 

THEY HAVE THOSE MICS ON? OH GOOD, THANK YOU. AS YOU CAN TELL,16 

THIS IS A FAMILY AFFAIR. MAYBE WE SHOULD TURN AROUND AND KIND17 

OF FACE OUR AUDIENCE HERE. HOW ARE YOU? GOOD. WELL FIRST OF18 

ALL, LET ME INTRODUCE YOU TO THE FAMILY OF ALBERT J. GOMEZ.19 

ALBERT IS A 17-YEAR VETERAN OF THE COUNTY OF LOS ANGELES20 

RECREATION SERVICES SUPERVISOR AT PAMELA PARK IN DUARTE IN THE21 

DEPARTMENT OF PARKS AND RECREATION. THE REASON THAT HE WAS22 

SELECTED IS BECAUSE THIS GENTLEMAN HAS DONE AN AWFUL LOT IN23 

OUR PARKS AND WE'RE VERY PROUD OF HIM. HE HAS INCORPORATED THE24 

SUCCESSES LEARNED FOR MOTIVATING HIS SON, NICOLAS, WHO WAS25 
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LEFT QUADRIPLEGIC FOLLOWING A TRAGIC ACCIDENT INTO PROGRAMS1 

THAT INSPIRE OUR YOUTH TO REACH HIGHER GOALS BEYOND THEIR2 

ASSUMED PHYSICAL OR MENTAL LIMITATIONS. SOME OF THE PROGRAMS3 

ESTABLISHED INCLUDE THE CHEER-OFF PROGRAM, WHICH ALLOWS YOUNG4 

GIRLS TO PARTICIPATE IN CHEERING COMPETITIONS, COUNTY CAPERS,5 

WHICH OFFERS YOUTH A CHANCE TO DANCE AND SING AND MUSICALS,6 

AND THE SCHIFF-CARDENAS GRANT WHICH ALLOWS THE EXPANSION OF7 

RECREATIONAL PROGRAMS FOR AT-RISK YOUTH. ALBERT AND HIS WIFE,8 

VIRGINIA, DISPLAY THEIR COMMUNITY ACTIVISM BY ESTABLISHING A9 

CAMPFIRE GROUP FOR YOUNG PEOPLE EIGHT TO 12 YEARS OF AGE THAT10 

GIVES THEM AN OPPORTUNITY TO LEARN ABOUT CAMPING AND PROVIDES11 

THEIR SON, NICOLAS, ALONG WITH THEIR OTHER TWO BOYS, ANDREW12 

AND JONAH, A MEANS TO TAKE PART IN ACTIVITIES THAT OTHERWISE13 

WOULD PROBABLY NOT BE AVAILABLE TO THEM. SO WE ARE RECOGNIZING14 

ALBERT FOR THESE ACCOMPLISHMENTS AND AS WELL AS HIS FAMILY. HE15 

IS VERY DEDICATED, WE ARE TOLD BY THE DEPARTMENT A VERY HARD16 

WORKER, WHICH WE ALWAYS APPLAUD, SO IT'S MY PLEASURE TO17 

CONGRATULATE AND PRESENT THIS SCROLL COMMENDING YOU AS THE18 

APRIL 2003 EMPLOYEE OF THE MONTH. SO IF YOU'LL JUST TURN THAT19 

AROUND, I THINK IT DESERVES RECOGNITION. [ APPLAUSE ]20 

21 

SUP. MOLINA: WOW. THERE'S A BOOBOO BABY TOO. LET ME TURN IT,22 

BEFORE I ASK YOU TO SPEAK, I'M GOING TO TURN OVER TO MR.23 

GALLAGHER TO SEE IF HE'D LIKE TO SHARE A COUPLE OF WORDS.24 

25 



April 15, 2003 

 18

MR. GALLAGHER: YEAH, I'D JUST LIKE TO ACKNOWLEDGE THIS HARD1 

WORK AND REALLY WHAT'S MOST IMPORTANT WITH HIM, ALBERT, IS2 

THAT HE'S A TRUE BELIEVER IN CHANGING THE COMMUNITY AND MAKING3 

IT A BETTER PLACE, AND IF ANYBODY DESERVES IT, YOU DO,4 

CONGRATULATIONS AND ESPECIALLY TO YOUR FAMILY. [ APPLAUSE ].5 

6 

ALBERT J. GOMEZ: THANK YOU. WELL I'D LIKE TO THANK THE BOARD7 

FOR THIS TIME. I'D ALSO LIKE TO DEDICATE THIS AWARD TO MY8 

FELLOW COLLEAGUES AND CO-WORKERS WHO COULDN'T BE HERE TODAY9 

WHO WORK TIRELESSLY DAY IN AND DAY OUT TO PROVIDE SERVICES10 

THROUGHOUT OUR COUNTY. I'D LIKE TO THANK ALL OF MY11 

SUPERVISORS, MY IMMEDIATE SUPERVISORS, MY TEACHERS, AND MY12 

MENTORS IN THE DEPARTMENT, ROY, JOYCE, MELINDA, KEITH13 

GARRISON, WHO IS A CO-WORKER WHO'S BEEN PROMOTED AND ALL THE14 

PEOPLE I'VE MET IN THE PAST WHO REALLY TAUGHT ME THIS BUSINESS15 

AND TO ALL MY EMPLOYEES, I WANT TO THANK THEM AS WELL, TOO.16 

THEY WORK HARD ALONG WITH ME. AND I WOULD LIKE TO THANK MY17 

WIFE FOR HER PATIENCE, MY SONS, OR OTHER KNOWN AS MY HEADACHE,18 

MY RECEDING HAIRLINE AND MY GRAY HAIRS FOR BEING PATIENT AND19 

UNDERSTANDING THAT THERE IS A LOT OF ME TO GO AROUND. THANK20 

YOU VERY MUCH.21 

22 

SUP. MOLINA: WELL ALBERT, WE COMMEND YOU ON BEHALF OF THE23 

BOARD OF SUPERVISORS. YOU'VE DONE AN OUTSTANDING JOB. WE'RE24 

PARTICULARLY PROUD OF THE KIND OF INSPIRATION THAT YOU PROVIDE25 
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TO ALL OF US. THE WORK THAT YOU DO IS TREMENDOUS. SO WE1 

APPLAUD YOU, AND I HAVE AN EMPLOYEE OF THE MONTH PIN THAT I'D2 

LIKE TO PRESENT. SO AGAIN CONGRATULATIONS AND CONGRATULATIONS3 

TO EVERYBODY-- AGAIN CONGRATULATIONS, COULD YOU JOIN ME IN4 

APPLAUDING ALBERT GOMEZ. [ APPLAUSE ]5 

6 

SUP. MOLINA: ALL RIGHT. ARE THERE ANY OTHER PRESENTATIONS?7 

SUPERVISOR ANTONOVICH?8 

9 

SUP. ANTONOVICH: FIRST WE WOULD LIKE TO RECOGNIZE AN10 

INDIVIDUAL AND SHOW YOU THE POWER OF WHAT A PERSON CAN DO, AND11 

THAT'S FROM OUR OWN ANTELOPE VALLEY, JOHNNY ZAMRZLA. JOHNNY IS12 

THE OWNER OF WESTERN PACIFIC ROOFING CORPORATION AND PRESIDENT13 

OF THE NATIONAL ROOFING CONTRACTORS ASSOCIATION. WHAT MAKES14 

THIS VERY IMPORTANT IS ON SEPTEMBER 11TH, WHEN WE WERE15 

ATTACKED AND THE PENTAGON WAS ATTACKED, ON FIRE, JOHNNY AND A16 

GROUP OF PEOPLE SAID, "WE WOULD LIKE TO REBUILD THE PENTAGON17 

FROM THAT TERRIBLE ATTACK." I WAS BACK IN WASHINGTON AT THAT18 

TIME AND STANDING ON TOP OF THE COMMERCIAL BUILDING OF LYNN19 

NOFFSINGER'S OFFICE, THREE BLOCKS FROM THE WHITE HOUSE, AND20 

RIGHT ACROSS FROM THE PENTAGON WATCHING IT ON FIRE, AND THAT'S21 

AN IMPACT IN MY LIFE THAT I WILL NEVER FORGET. BUT HERE JOHNNY22 

IN THE ANTELOPE VALLEY SAID, "WE WILL REBUILD THAT, WE WILL23 

VOLUNTEER OUR TIME TO REBUILD THE PENTAGON," AND SO WHAT THEY24 

DID, THIS IS THE FIRST SUCCESSFUL PUBLIC/PRIVATE PARTNERSHIP25 
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WHERE HE NEGOTIATED AN AGREEMENT WITH THE DEPARTMENT OF1 

DEFENSE TO REBUILD THE ROOF OF THE PENTAGON AFTER THAT ATTACK.2 

THEY RAISED, THE ROOFING ASSOCIATION, RAISED OVER $500,000 IN3 

CASH AND SUPPLIES NEEDED TO COMPLETE THAT JOB. THEY WERE4 

ACTIVELY INVOLVED IN THE WATERPROOFING INDUSTRY AND ROOFING5 

INDUSTRY SINCE 1957, JOHNNY HAS BEEN WITH THAT EXPERIENCE, AND6 

HE WAS ABLE TO GET ALL OF THE PEOPLE IN THAT INDUSTRY TO COME7 

FORWARD TO REBUILD OUR PENTAGON AND NOT ALLOW WHAT HAD8 

OCCURRED TO REMAIN, AND HE DID THAT FROM THE PRIVATE SECTOR9 

AND THE POWER OF ONE INDIVIDUAL. SO JOHNNY, WE'D LIKE TO THANK10 

YOU FOR TAKING THE INITIATIVE, NOT JUST FOR THE UNITED STATES,11 

BUT FOR THE WORLD TO SEE AS WELL AND THANK YOU FOR YOUR12 

LEADERSHIP. [ APPLAUSE ]13 

14 

JOHNNY ZAMRZLA: WELL, THANK YOU, MICHAEL, AND BOARD OF15 

SUPERVISORS FOR GIVING ME TIME TO RECEIVE THIS PRESENTATION.16 

I'D REALLY LIKE TO THANK ALL THE MEMBERS OF THE INDUSTRY WHO,17 

SOME 200, THAT CHIPPED IN TO MAKE THE ROOFING A SUCCESSFUL18 

ENTITY AND BE ABLE TO PROVIDE IT ON TIME. IT WAS INTERESTING19 

THAT EVEN WITH THE PRIVATE SECTOR DONATING THE INSTALLATION OF20 

THE ROOF, IT WAS DONE AHEAD OF SCHEDULE SOME NINE MONTHS AND21 

PUT THE PENTAGON BACK INTO OPERATION, SO ON BEHALF OF ALL THE22 

PEOPLE THAT PARTICIPATED, I THANK YOU VERY MUCH. [ APPLAUSE ]23 

24 
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SUP. ANTONOVICH: NOW WE WOULD LIKE TO RECOGNIZE AN INDIVIDUAL1 

WHO SERVED ALMOST 34 YEARS IN OUR DISTRICT ATTORNEY'S OFFICE,2 

A GOOD FRIEND, NICK MIKULICICH, WHO IS NOW RETIRING AT A VERY,3 

VERY YOUNG AGE. PRIOR TO SERVING AS THE TRIAL ATTORNEY FOR4 

FELONIES AND MISDEMEANORS, HE SERVED AS HEAD OF THE5 

MEDICAL/LEGAL SECTION AND IS DEPUTY IN CHARGE OF COMPTON6 

JUVENILE BRANCH. HE STARTED THE INGLEWOOD DRUG COURT PROGRAM7 

SERVING AS INITIAL DEPUTY IN CHARGE AND ALSO REPRESENTED THE8 

DISTRICT ATTORNEY'S OFFICE AT PAROLE HEARINGS AT THE BOARD OF9 

PRISON TERMS. HE'S BEEN ACTIVE WITHIN THE COMMUNITY SERVING IN10 

MANY VITAL ROLES SUCH AS A LECTURER FOR THREE LOS ANGELES11 

DISTRICT ATTORNEYS SPEAKERS' BUREAUS SINCE 1970 AND HE'S12 

ARBITRATOR FOR THE LOS ANGELES COUNTY SUPERIOR COURT, AND WE13 

WOULD LIKE TO RECOGNIZE NICK AND HIS LOVELY FAMILY FOR THEIR14 

CONTRIBUTIONS AND, LET'S SEE, YOU GRADUATED FROM U.C.L.A. AT,15 

WHAT, 16, 20? GRADUATED FROM U.C.L.A. LAW SCHOOL AT AGE 20 AND16 

YOU GRADUATED, WHAT, OKAY. SO HE'S RETIRING YOUNG AND HIS17 

CHILDREN STARTED YOUNG GOING THROUGH COLLEGE, SO THAT'S A REAL18 

CREDIT, SO CONGRATULATIONS. [ APPLAUSE ]19 

20 

NICK MIKULICICH: I'M SORRY I DIDN'T PREPARE A SPEECH, BUT I'VE21 

BEEN HONORED AND PRIVILEGED TO SERVE AS THE DISTRICT ATTORNEY22 

IN LOS ANGELES COUNTY AS A DEPUTY AND I'VE ALWAYS FELT THAT TO23 

SERVE ON BEHALF OF THE PEOPLE OF THE STATE OF CALIFORNIA IS A24 

VERY NOBLE POSITION TO HAVE AND WE ATTEMPT TO SEEK JUSTICE AND25 
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WITH THAT PRINCIPLE IN MIND, WE CONTINUE TO WORK AT ALL TIMES1 

SEEKING JUSTICE. I NOTE THROUGH THE ALMOST 34 YEARS THAT IT'S2 

A VERY HONORABLE OFFICE, IT DOES SEEK JUSTICE AND THIS ONLY3 

ENCOURAGES ME TO WORK AND ON BEHALF OF SEEKING JUSTICE4 

FURTHER. THANK YOU. [ APPLAUSE ]5 

6 

SUP. ANTONOVICH: AND OUR LAST RETIREE IS LOU AGUILAR FROM THE7 

COUNTY COUNSEL'S OFFICE, AND HE'S BEEN WITH THE COUNTY FOR8 

ALMOST 30 YEARS. HE JOINED THE L.A. COUNTY MARSHALL'S OFFICE9 

SERVING IN THE FIELD DIVISION, AND LATER AS A BAILIFF IN THE10 

TRIALS' DIVISION, AND THEN ATTENDED LAW SCHOOL, GRADUATING11 

FROM SOUTHWESTERN. HE TRANSFERRED TO THE COUNTY COUNSEL'S12 

OFFICE, WHERE HE ROSE THROUGH THE RANKS OF DEPUTY COUNTY13 

COUNSEL TO THE POSITION OF SENIOR ASSISTANT COUNTY COUNSEL.14 

HE'S MADE MANY CONTRIBUTIONS TO OUR COUNTY, TO THE COUNTY15 

COUNSEL'S OFFICE, SERVING AS THE CHIEF OF THE WORKERS'16 

COMPENSATION AND GENERAL LITIGATION DIVISIONS. SO, LOU, AT17 

THIS TIME, CONGRATULATIONS AND HE'S COMING UP. HE'S STILL18 

LITIGATING. HE'S GOING TO BE HERE? OKAY, SO WE'LL DO THE DOG19 

AND MAYBE WE'LL -- AND WE'LL FIND A HOME FOR LOU AND THE DOG?20 

OKAY. WE'LL DELAY ON LOU UNTIL WE HAVE A LITTLE FRIEND NAMED21 

WILLIE WHO IS THREE YEARS OLD, A LITTLE CHIHUAHUA MIX. I THINK22 

MORE MIX THAN CHIHUAHUA. AND WILLIE'S LOOKING FOR A HOME, SO23 

IF ANYBODY WOULD LIKE TO ADOPT WILLIE, YOU CAN CALL THE24 

TELEPHONE NUMBER AT THE BOTTOM OF YOUR SCREEN, WHICH IS AREA25 
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CODE 562-728-4644, AND LITTLE WILLIE CAN BE YOURS. I SAID HE'S1 

A CHIHUAHUA MIX, BUT HE'S BIGGER ON THE MIX THAN THE2 

CHIHUAHUA. CAN YOU SAY DEL TACO? TACO BELL? WHAT'S IT, WHAT'S3 

THE COMMERCIAL? WHAT WE'LL DO, WE'RE GOING TO DELAY ON LOU4 

UNTIL HE SHOWS UP FROM THE RAIN AND WE'LL GIVE THAT5 

PRESENTATION THEN. SO, MS. MOLINA, WE'RE READY TO RETURN BACK6 

TO THE AGENDA. HOW YOU GOIN' BILL. OKAY, MUCHO GRAS. TAKE7 

CARE. I SAW -- I WAS WONDERING IF YOU HAD A CLIENT UP HERE.8 

OKAY, I'LL SEE YOU AT THE ENGINEERS' STUFF.9 

10 

SUP. MOLINA: DOES THAT CONCLUDE YOUR PRESENTATIONS?11 

12 

SUP. ANTONOVICH: YES. WELL AGUILAR, HE DIDN'T SHOW UP.13 

14 

SUP. MOLINA: HE DIDN'T SHOW. ALL RIGHT. AND MR. YAROSLAVSKY,15 

DO YOU HAVE ANY PRESENTATIONS TODAY? NO? ALL RIGHT. LET ME DO16 

SOME OF THE ADJOURNMENTS ON BEHALF OF MY COLLEAGUES. FIRST OF17 

ALL, I'D LIKE TO ADJOURN IN -- IN THE MEMORY OF CELESTE KING.18 

THIS IS A JOINT MOTION BY SUPERVISOR BURKE AND SUPERVISOR19 

KNABE. ALL OF US HAD AN OPPORTUNITY TO WORK ALONGSIDE OF20 

CELESTE KING. HE'S A LONG-TIME CIVIL RIGHTS FIGHTER AND21 

FOUNDING STATE CHAIRMAN OF THE CONGRESS OF RACIAL EQUALITY. HE22 

PASSED AWAY ON SATURDAY, APRIL 12TH, OF A VARIETY OF AILMENTS,23 

INCLUDING KIDNEY FAILURE. HE WAS 79 YEARS OLD. IN HIS LONG AND24 

DISTINGUISHED CAREER MR. KING SERVED AS THE SECOND DISTRICT25 
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COMMISSIONER FOR THE LOS ANGELES COUNTY VETERANS ADVISORY1 

COMMISSION, CO-FOUNDER OF THE BROTHERHOOD CRUSADE IN LOS2 

ANGELES, AND WAS INSTRUMENTAL IN THE RENAMING OF MARTIN LUTHER3 

KING, JR. BOULEVARD IN SOUTH LOS ANGELES. HE SERVED AS AN4 

OFFICER OF THE TUSKEGEE AIRMEN, AS WE ALL KNOW, AN ALL-BLACK5 

UNIT OF THE ARMY AIR CORPS GUARD. WE CERTAINLY ARE GOING TO6 

MISS HIM. MR. KING IS SURVIVED BY HIS WIFE OF 62 YEARS, ANITA7 

LUGO KING, WHO SERVED AS A FOURTH DISTRICT APPOINTEE TO THE8 

LOS ANGELES COMMISSION FOR WOMEN FOR 17 YEARS. TWO SONS, HIS9 

DAUGHTER AND EIGHT GRANDCHILDREN. SO ON BEHALF OF SUPERVISOR10 

BURKE AND SUPERVISOR KNABE, WE'D LIKE TO ADJOURN IN HIS11 

MEMORY, AND I THINK ALL MEMBERS WOULD LIKE TO JOIN IN ON THAT.12 

ON BEHALF OF SUPERVISOR KNABE, I'D ALSO ASK THAT WE ADJOURN13 

TODAY IN THE MEMORY OF JAMES SHOFUKU ISHIHARA, THE 93-YEAR-OLD14 

FATHER OF NANCY OH WHO IS THE EXECUTIVE DIRECTOR OF THE15 

WESTERN REGION ASIAN PACIFIC AGENCY. MR. ISIHARA PASSED AWAY16 

RECENTLY IN HAWAII. I WOULD LIKE TO ADJOURN IN THE MEMORY OF17 

HARRIS RAVENS, WHO IS A -- WAS A PROUD U.S. VETERAN AND THE18 

HUSBAND OF PHYLLIS RAVENS, WHO IS A LONG-TIME MONTEREY PARK19 

ACTIVIST. SHE'S BEEN A DEAR FRIEND AND A TREMENDOUS SUPPORTER.20 

IT'S AN UNFORTUNATE LOSS FOR PHYLLIS AND HER FAMILY, BUT WE21 

WANT TO EXTEND OUR DEEPEST CONDOLENCES TO ALL OF THEM. I'D22 

ALSO LIKE TO ASK THAT WE ADJOURN IN THE MEMORY OF MR. CARLOS23 

ULGHINE WHO PASSED AWAY. HE WAS 98 YEARS OLD. MR. ULGHINE WAS24 

THE GRANDFATHER OF MY GOOD FRIEND, LORRAINE ALVAREZ OPPER.25 



April 15, 2003 

 25

LORRAINE MANY YEARS AGO USED TO WORK FOR SUPERVISOR EDELMAN1 

HERE AT THE HALL. MR. ULGHINE WAS A LONG-TIME AND DEDICATED2 

COMMUNITY ACTIVIST WHO FOR MANY YEARS DEVOTED HIMSELF TO3 

HELPING YOUTH AND FIGHTING CRIME IN HIS SOUTH CENTRAL4 

NEIGHBORHOOD. IN 1972, HE FOUNDED THE NONPROFIT ADAMS AND5 

VERMONT COMMUNITY CENTER AND OVER THE YEARS HE WORKED6 

DILIGENTLY TO MAKE HIS COMMUNITY SAFE, PROMOTE INTERRACIAL7 

UNDERSTANDING, BEAUTIFY THE NEIGHBORHOOD AND OFFER EMPLOYMENT8 

AND CULTURAL ACTIVITIES FOR YOUTH. MR. UHLGINE IS SURVIVED BY9 

FIVE OF HIS NINE CHILDREN, HIS SISTER, AND FIVE GENERATIONS OF10 

GRANDCHILDREN, GREAT GRANDCHILDREN, AND GREAT, GREAT11 

GRANDCHILDREN. SO I'D LIKE TO ADJOURN IN HIS MEMORY AND I12 

SHARE OUR CONDOLENCES TO HIS DAUGHTER MRS. HELEN ALVAREZ.13 

ALSO, ON BEHALF OF SUPERVISOR BURKE, WE WOULD LIKE TO ASK THAT14 

WE ADJOURN IN THE MEMORY OF MARJORIE PADORA SILVERSTEIN. SHE15 

PASSED AWAY IN MARCH DUE TO COMPLICATIONS OF LIVER FAILURE. AN16 

AUTHOR, LECTURER, RADIO AND TELEVISION PERSONALITY, MISS17 

SILVERSTEIN WON THE PEABODY AWARD IN 1970 FOR RADIO NEWS AND18 

INVESTIGATIVE REPORTING. SHE WAS APPOINTED TO THE BOARD OF19 

CHILDREN'S PLANNING COUNCIL IN 2001 AND WAS ALSO THE MEMBER OF20 

THE BUILDING COUNTYWIDE COMMITMENT TO OUTCOMES COMMITTEE. HER21 

PRESENCE AND ACTIVE PARTICIPATION WILL BE MISSED. SHE'S22 

SURVIVED BY HER LIFE PARTNER, JEROME APPLEBOMB. SO THAT'S ON23 

BEHALF OF SUPERVISOR BURKE. I AM UP FIRST, BUT BEFORE WE DO24 

THAT, I'M GOING TO CALL ON THE C.A.O. TO REPORT ON -- WE'RE25 
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CONTINUING THE BUDGET ITEM BUT WE'D STILL LIKE A BRIEF1 

DISCUSSION FROM THE C.A.O.2 

3 

C.A.O. JANSSEN: JUST A VERY BRIEF PRESENTATION, MADAM CHAIR,4 

BOARD MEMBERS, AND THEN THE ITEM WILL BE CONTINUED TO THE5 

29TH. THE PROPOSED BUDGET FOR 2003/2004 REFLECTS A 2 PERCENT6 

REDUCTION FROM THE CURRENT YEAR, A TOTAL OF $16.5 BILLION, AND7 

A 2.3 PERCENT REDUCTION IN STAFF, 2,158 POSITIONS BEING8 

REDUCED. THE TOTAL SHORTFALL THAT IS ADDRESSED IN THIS BUDGET9 

IS $804 MILLION. IN ADDITION TO THE STRUCTURAL DEFICIT IN THE10 

GENERAL FUND OF $205 MILLION, THE BUDGET ALSO REFLECTS A $37211 

MILLION PROBLEM IN THE DEPARTMENT OF HEALTH SERVICES, WHICH12 

YOU HAVE BEEN DEALING WITH FOR SEVERAL MONTHS, AND AN13 

ADDITIONAL 226 MILLION DEFICIT IN MANY DEPARTMENTS WHICH14 

REFLECTS A COMBINATION OF COST INCREASES AND STATE BUDGET15 

SHORTFALLS THAT CANNOT BE RESOLVED WITHOUT ADDITIONAL16 

REDUCTIONS. THE RECOMMENDATIONS IN THE BUDGET ELIMINATE THESE17 

DEFICITS THROUGH A COMBINATION OF ONE-TIME AND ONGOING18 

MEASURES. IN THE GENERAL FUND, WE'RE PROPOSING TO USE 109.719 

MILLION OF RESERVES FOR ONE-TIME PROBLEMS, PRIMARILY RELATED20 

TO FOOD STAMP ERROR RATE SB 90 MANDATE CLAIMS, AND WE HAVE21 

INCLUDED AT THIS TIME $17 MILLION FOR THE LAKUS PROGRAM WHICH22 

HAS YET TO BE RESOLVED WITH YOUR BOARD, AND $66.1 MILLION IN23 

PROGRAM REDUCTIONS, ABOUT 10 MILLION IN DEFERRALS AND ABOUT 2024 

MILLION IN NEW REVENUE. AND THE HEALTH DEPARTMENT REFLECTING25 
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DECISIONS THAT YOU'VE ALREADY MADE, REDUCTIONS OF 174 MILLION1 

NEXT YEAR AND USING RESERVES OF 197 MILLION. THE REMAINING 2262 

MILLION WILL BE REDUCTIONS IN VARIOUS DEPARTMENTS. AS REPORTED3 

IN THE PRESS, THE DEPARTMENTS THAT ARE MOST SIGNIFICANTLY4 

IMPACTED BY THIS, THE SHERIFF'S DEPARTMENT, LIBRARIES, SOCIAL5 

SERVICES, DISTRICT ATTORNEY, HEALTH DEPARTMENT, OBVIOUSLY. THE6 

PROBLEM IS A COMBINATION OF IT'S NOT A SIMPLE -- IT'S NOT A7 

SIMPLE BUDGET, WE DO HAVE A SHORTFALL IN LOCAL REVENUES THAT8 

HAS WORSENED SINCE LAST YEAR, PARTICULARLY IN REALIGNMENT AND9 

PROP 172 SALES TAX FOR PUBLIC SAFETY. WE HAVE PRETTY DRAMATIC10 

INCREASES IN WORKERS' COMPENSATION, ALMOST A 20 PERCENT11 

INCREASE, $57 MILLION A YEAR, THAT'S A SIGNIFICANT PART OF THE12 

SHERIFF'S PROBLEM AND WE HAVE PRETTY SIGNIFICANT INCREASES IN13 

THE COST OF RETIREE HEALTH. WE HAVE ADDRESSED A SMALL PORTION14 

OF THE STATE BUDGET PROBLEM IN THE BUDGET, ALTHOUGH THE BIG15 

PROBLEM IS OBVIOUSLY STILL OUT THERE WAITING FOR THE STATE TO16 

DECIDE HOW IT'S GOING TO BALANCE ITS BUDGET AND WHAT17 

ADDITIONAL PROBLEMS WE MAY BE CAUSED WHEN THEY DO THAT. OUR18 

OWN LOCAL REVENUE, JUST AS AN EXAMPLE, IS ONLY A NET $6219 

MILLION IN THE GENERAL FUND, AND WE HAVE $260 MILLION WORTH OF20 

EXPENDITURES, WHICH RESULTS IN THE 205 SHORTFALL. I HAVE NOT21 

INCLUDED ANY MONEY FOR SALARY INCREASES FOR THE NEXT ROUND OF22 

CONTRACT NEGOTIATIONS, WHICH ARE UNDERWAY FOR OUR PUBLIC23 

SAFETY CHILDREN'S SERVICES PROBATION DEPARTMENTS. THAT WOULD24 

ADD A SIGNIFICANT COST TO THE BUDGET. ALL OF THESE ISSUES WILL25 
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BE OPEN FOR PUBLIC HEARING BEGINNING ON MAY THE 14TH FOR A 10-1 

DAY PERIOD AND YOUR BOARD WILL DELIBERATE THE ITEMS STARTING2 

THE LAST WEEK OF JUNE. I'D BE HAPPY TO ANSWER ANY QUESTIONS3 

YOU HAVE, BUT --4 

5 

SUP. MOLINA: ARE THERE ANY QUESTIONS FROM MEMBERS AT THIS6 

POINT?7 

8 

SUP. ANTONOVICH: WELL I'VE A --9 

10 

SUP. MOLINA: SUPERVISOR ANTONOVICH.11 

12 

SUP. ANTONOVICH: QUESTION. IN DECEMBER, WHEN THE GOVERNOR13 

INDICATED WE HAD TO HAVE MAJOR REVISIONS BECAUSE OF THE14 

DEFICIT, THERE WAS A SPECIAL SESSION, THERE WAS THE NEED TO15 

TAKE IMMEDIATE ACTION, AND I READ BECAUSE THEY HAVE STILL16 

DELAYED TO TAKE THAT IMMEDIATE ACTION, THERE WAS ANOTHER17 

BILLION DOLLARS OR SO LOST IN SAVINGS. AND WHAT I FIND18 

CONFUSING, THE LEGISLATURE NOW GOES INTO RECESS, AND FROM19 

HAWAII AND OTHER EXOTIC PLACES ARE NOT SITTING DOWN AND20 

NEGOTIATING A BUDGET THAT WILL ENSURE EACH COMMUNITY WITH THE21 

NECESSARY RESOURCES TO GET THE JOB DONE. I AM COMPLETELY22 

FRUSTRATED WITH THIS PROCESS. YOU HAVE 120 MEMBERS OF A23 

LEGISLATURE, YOU HAVE A GOVERNOR, AND THEIR FIRST PRIORITY IS24 

NEGOTIATING A BUDGET, AND YET THEY'RE NOT SITTING DOWN AND25 
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NEGOTIATING THE BUDGET. AND AS A RESULT, THEY'RE TALKING ABOUT1 

CATASTROPHIC ELIMINATION OF VITAL SERVICES REGARDING PUBLIC2 

SAFETY AND OTHER ESSENTIAL SERVICES. AND WE DON'T HAVE THE3 

ABILITY OF MOVING FORWARD UNTIL THE LEGISLATURE ADOPTS THEIR4 

REVISION AND THEIR NEW BUDGET. SO WE ARE LEFT HANGING BY A5 

THREAD AND IT'S AS IF THE HOUSE IS ON FIRE AND THE FIRE6 

DEPARTMENT TAKES A VACATION INSTEAD OF PUTTING OUT THE FIRE,7 

AND WHAT'S GOING TO END UP IS GOING TO BE A STRUCTURE THAT'S8 

BURNT DOWN TO THE GROUND. AND WE TALK ABOUT THE COUNTY HAVING9 

90,000 EMPLOYEES -- WE ACTUALLY HAVE ABOUT 45,000 EMPLOYEES10 

AND ANOTHER 45,000 ARE CONTRACT EMPLOYEES TO THE CITIES OF11 

WHICH OVER HALF CONTRACT FOR THE COUNTY FOR SERVICES. THOSE12 

CITIES CAN'T COMPLETE THEIR BUDGETS WITHOUT HAVING SEVERE13 

IMPACTS, WHICH MEANS 45,000 OF OUR COUNTY EMPLOYEES ARE14 

BEHOLDEN TO THE BUDGETS OF THOSE RESPECTIVE CITIES, AND THIS15 

IS A VERY DYSFUNCTIONAL PROCESS BECAUSE WE DON'T HAVE THE16 

MANEUVERABILITY OR THE FLEXIBILITY TO MOVE FORWARD. SO YOU'RE17 

KIND OF IN A -- NOT KIND OF, YOU ARE IN A CATCH 22 POSITION.18 

I'VE SENT LETTERS TO EVERY CITY COUNCIL MEMBER, EVERY19 

SUPERVISOR IN THE STATE, SAYING IT TO EVERY CITY MANAGER AND20 

TO EVERY ASSESSOR IN THE ASSESSOR'S ASSOCIATION AND THEIR21 

EXECUTIVE BOARDS, THE LEAGUE OF CITIES, THE CONTRACT CITIES22 

AND THE INDEPENDENT CITIES AND C.S.A.C., THAT IT IS ESSENTIAL23 

THAT THE LEADERSHIP SIT DOWN AND NEGOTIATE AN INITIATIVE ON24 

FINANCING LOCAL GOVERNMENT, TO HAVE THE STATE TAKE FIVE CENTS25 
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OUT OF EVERY EIGHT AND A QUARTER CENT SALES TAX IN L.A. COUNTY1 

IS ABSURD. THOSE DOLLARS SHOULD BE REMAINING IN THE2 

COMMUNITIES, BUT HAVING A FAIR FORMULA ON PROPERTY TAX AND ON3 

SALES TAX TO REMAIN FOR LOCAL VITAL SERVICES. THERE ARE A4 

GROUP OF PEOPLE NOW THAT ARE ADVOCATING A 10 PERCENT INCREASE5 

IN TAXES ON INCOME TAXES FOR CITIES AND COUNTIES. THAT'S6 

NONSENSE, THE PROBLEM ISN'T HIGHER TAXES, IT'S GETTING A7 

BETTER RETURN ON THE TAXES WE ALREADY PAY. WE ALREADY ARE8 

PAYING A LARGE SUM OF TAXES, WE'RE NOT UNDERTAXED. BUT NOW TO9 

BEGIN INITIATING A TAX ON INCOME TAX? ALONG WITH THE TALK OF10 

AN ADDITIONAL ONE CENT SALES TAX, I MEAN, THEY OUGHT TO BE11 

LOOKING AT WAYS OF CUTTING OUT INEFFICIENCIES AND GETTING A12 

BETTER RETURN ON THEIR DOLLARS, BUT RIGHT NOW, THERE IS NO13 

LEADERSHIP. SO LOCAL GOVERNMENT OUGHT TO TAKE THE LEADERSHIP14 

AND PROVIDE AN INITIATIVE, GET IT QUALIFIED FOR THE MARCH 200415 

BALLOT THAT WOULD HAVE A FAIR DISTRIBUTION OF SALES TAX,16 

PROPERTY TAXES, SO THAT CITIES, COUNTIES, AND SCHOOLS WOULD17 

HAVE A STABLE SOURCE OF FUNDING. OTHERWISE THEY'RE GOING TO BE18 

LEFT TO A GROUP OF PEOPLE WHO WOULD PREFER NOT TO NEGOTIATE19 

AND TO FOREGO THEIR RESPONSIBILITIES, AS HAS BEEN DONE SINCE20 

DECEMBER OF 2002 WITH THIS CURRENT BUDGET FIASCO.21 

22 

SUP. MOLINA: ALL RIGHT. AT THIS POINT IN TIME, JUST AS -- MR.23 

YAROSLAVSKY?24 

25 
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SUP. YAROSLAVSKY: MADAM, MADAM CHAIR, JUST FOR A SECOND,1 

'CAUSE I CAN'T RESIST THE --2 

3 

SUP. MOLINA: I KNOW, TO PARTICIPATE THE POLITICAL DISCUSSION.4 

5 

SUP. YAROSLAVSKY: NO, NO, NOT WHAT YOU THINK. I HAVE TO SAY6 

THAT EVEN IN THIS ENVIRONMENT, WITH THE STATE BUDGET IN A FREE7 

FALL, IN THE LAST TWO DAYS I'VE LEARNED, AND MAYBE I WAS THE8 

LAST TO LEARN ABOUT IT, BUT IT PAYS TO READ THE SACRAMENTO BEE9 

ONCE IN A WHILE, OF TWO BILLS THAT ARE WORKING THEIR WAY10 

THROUGH THE LEGISLATURE, ONE WHICH WOULD DOUBLE THE AMOUNT OF11 

TIME THAT CERTAIN OF OUR EMPLOYEES, PUBLIC SAFETY EMPLOYEES12 

WHO ARE INJURED ON DUTY, DOUBLE THE AMOUNT OF TIME THEY WOULD13 

GET FULL SALARY TAX-FREE FROM ONE TO TWO YEARS. APPARENTLY14 

THEY GET A ONE-YEAR TAX-FREE FULL SALARY IF THEY'RE INJURED ON15 

DUTY. THIS WOULD DOUBLE IT TO TWO YEARS. PARENTHETICALLY, THE16 

ONLY -- ONE OF THE ONLY TWO MEMBERS OF THE COMMITTEE TO VOTE17 

AGAINST THIS BILL WAS A REPUBLICAN WHO'S A FORMER POLICE18 

OFFICER, SO HE UNDERSTOOD THE PREPOSTEROUSNESS OF THAT BILL.19 

AND THEN TODAY I READ DAN WEINTRAUB'S COLUMN OF A -- IN THE20 

SACRAMENTO BEE WHERE THERE'S A BILL BEING PUSHED THAT WOULD21 

INCREASE THE ABILITY OF JUST POLICE OFFICERS, IT MAY INCLUDE22 

OTHERS IN PUBLIC SAFETY, BUT POLICE OFFICERS AT LEAST, TO BE23 

ABLE TO RETIRE AT A HUNDRED PERCENT, NO OFFENSE, STEVE, I WISH24 

YOU WELL, AND UNDER THIS BILL, YOU'LL DO QUITE WELL, A HUNDRED25 
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PERCENT OF SALARY. AT A HUNDRED PERCENT OF SALARY. JUST BY WAY1 

OF COMPARISON RIGHT NOW IN THIS COUNTY YOU RETIRE AFTER 252 

YEARS, YOU CAN RETIRE AT 50 PERCENT OF SALARY, AND IT'S IN3 

THAT RANGE, 50 -- AND THE LAW HAS PREVIOUSLY BEEN IN THE 50 TO4 

75 PERCENT, AND THIS WOULD TAKE IT TO A HUNDRED PERCENT5 

SALARY. SO AFTER 33 YEARS OF EMPLOYMENT, YOU COME IN AT AGE6 

20, YOU WORK 'TIL YOU'RE 53, AND YOU RETIRE AT A HUNDRED7 

PERCENT OF SALARY. NOW, BEFORE I GOT HERE, I THINK THE COUNTY8 

HAD A KIND OF A SIMILAR, IT'S CALLED PLAN A, IT WASN'T QUITE9 

AS RICH, NOT NEARLY AS RICH, BUT IT CREATED ALL THIS10 

CONTROVERSY AND YOU WENT AND REFORMED IT. THIS IS GOING IN THE11 

OTHER DIRECTION. SO I'M JUST AMAZED. IS THERE ANYBODY HOME IN12 

SACRAMENTO? DO THEY GET IT? AS TO WHAT THEY'RE DOING TO THEIR13 

CONSTITUENT GOVERNMENTS, STATES, CITIES, AND COUNTIES? AND14 

IT'S JUST -- THESE ARE JUST TWO BILLS IN WHAT IS A LONG LIST15 

OF SPECIAL INTEREST BILLS THAT ARE WORKING THEIR WAY THROUGH16 

THE LEGISLATURE. SOME WILL SUCCEED AND SOME WILL FAIL, BUT ALL17 

IT TAKES IS ONE OR TWO TO SUCCEED AND THE HIT ON A COUNTY LIKE18 

THIS COULD BE IN THE TENS OF MILLIONS OF DOLLARS. SO WHEN19 

PEOPLE ASK AS THEY DID OF YOU, MR. JANSSEN, YESTERDAY, "WHAT'S20 

THE CAUSE OF ALL THIS BIG DEFICIT, WHY ARE WE IN THE MESS21 

WE'RE IN?" IT'S BECAUSE NOBODY'S MINDING THE STORE, THAT WHILE22 

THE STATE'S GOING DOWN, THE LEGISLATION THAT'S WORKING ITS WAY23 

THROUGH THE LEGISLATURE AND TO THE GOVERNOR'S DESK IS24 

APPARENTLY OBLIVIOUS TO THAT FACT, TOTALLY OBLIVIOUS TO THAT25 
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FACT. THE LEFT HAND DOESN'T APPEAR TO KNOW WHAT THE RIGHT HAND1 

IS DOING. ANOTHER CASUALTY PROBABLY OF TERM LIMITS. YEAH.2 

3 

C.A.O. JANSSEN: C.S.A.C. HAS BEEN TRACKING, OBVIOUSLY, THE4 

BILLS IN SACRAMENTO. THERE ARE UP TO 300 NOW THAT HAVE5 

MANDATES IN THEM FOR LOCAL GOVERNMENT, OVER 300 BILLS.6 

7 

SUP. YAROSLAVSKY: SO C.S.A.C. BETTER WAKE UP ON THIS LAST8 

BILL. YOU'RE GOING TO CHECK THAT OUT FOR ME, BUT ANYWAY, THANK9 

YOU.10 

11 

SUP. MOLINA: ALL RIGHT. SO MUCH FOR ADDRESSING THE LEADERSHIP12 

OF SACRAMENTO. BUT OUR RESPONSIBILITY HERE, AS I UNDERSTAND IT13 

CORRECTLY, IS -- AND WE'LL GET A FULL PRESENTATION OF OUR14 

BUDGET ON THE 29TH, IS THAT CORRECT, AND THEN THERE'LL BE THE15 

APPROPRIATE HEARINGS AND SO ON, AND IT'LL BE THE INTENTION OF16 

THIS BOARD TO PASS A BALANCED BUDGET IN JUNE, AND THEN MORE17 

THAN LIKELY AWAIT THE CONCLUSION OF THE LEGISLATURE IN ORDER18 

TO MAKE ANY REVISIONS, BUT IT IS -- WE ARE OF THE HIGHEST19 

HOPES, NUMBER ONE, THAT THEY DON'T PASS THROUGH ANY FURTHER20 

MANDATES BECAUSE I THINK WE'RE ON OVERLOAD NOW, WE'RE BARELY21 

GOING TO BE MEETING THEM, AND SECOND OF ALL, THAT DID NOT TAKE22 

AWAY FROM OUR PROPERTY BASE AND CERTAINLY OUR REVENUES THAT23 

ARE COMING IN AS WELL. BUT THAT IS -- WE HAVE TO WAIT TO SEE24 

WHAT'S GOING ON, AND I GUESS WE'RE GOING TO HAVE TO CONTINUE25 
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TO MOVE OURSELVES UP TO SACRAMENTO AND ENGAGE OURSELVES IN THE1 

DISCUSSION 'CAUSE THERE IS ACTIVITY, MAYBE NOT IN THE2 

APPROPRIATE DIRECTION. I KNOW I'M GOING UP FOR A HEARING THAT3 

IS GOING TO BE HELD BY ASSEMBLY WOMAN CHOU ON THE ISSUE OF THE4 

HEALTH BUDGET, AND IT IS MY HOPE THAT WE CAN EDUCATE THE5 

LEGISLATURE ON HOW OUR BUDGET, THE LIMITATIONS OF OUR BUDGET,6 

BECAUSE I, TOO, AM EQUALLY CONCERNED WITH THE CONTINUING7 

MANDATES THAT THEY HAVE PUT ON OUR HEALTH BUDGET AND NOT8 

GETTING US TO FULLY MEET THE NEEDS OF OUR LOCAL COMMUNITY AND9 

THEIR COUNTY RESIDENTS HERE. BUT WITH THAT, THIS ITEM IS NOW10 

GOING TO BE CONTINUED TO THE 29TH. ALL RIGHT. THE NEXT ITEM11 

THAT I HAVE IS ITEM NUMBER 12. ON ITEM NUMBER 12, THIS IS A12 

MOTION BY SUPERVISOR ANTONOVICH, AND AGAIN, I DON'T HAVE A13 

PROBLEM WITH THIS POLICY. IT'S A POLICY THAT I PROBABLY COULD14 

SUPPORT. IT IS MY UNDERSTANDING THAT THE DEPARTMENT OF15 

CHILDREN SERVICES THINKS IT'S REPETITIVE FROM THE STANDPOINT16 

THAT THEY'RE ALREADY UNDER THE CONTROL OF THE DEPARTMENT, BUT17 

I DON'T HAVE NO PROBLEM -- I DON'T HAVE A PROBLEM WITH STATING18 

THAT POLICY. THE PROBLEM I HAVE, THOUGH, SUPERVISOR19 

ANTONOVICH, IS THE FACT THAT WE ARE ACCEPTING AN UNFUNDED20 

MANDATE. THIS WOULD NOW REQUIRE US TO CARRY -- TO HAVE MORE21 

SOCIAL WORKERS TO CARRY OUT THIS KIND OF WORK WHICH, WHILE22 

IT'S GOOD WORK, IF WE DON'T HAVE THE ABILITY TO PAY FOR THE23 

SOCIAL WORKERS, IT MINIMIZES THE OTHER WORK THAT THEY'RE24 
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DOING. SO I WOULD BE WILLING TO SUPPORT IT IF YOU AMEND IT1 

THAT IT BE A FULLY FUNDED IF WE'RE GOING TO ACCEPT IT.2 

3 

SUP. ANTONOVICH: THAT'S FINE, THAT'S FINE.4 

5 

SUP. MOLINA: SO WITH THAT AMENDMENT, IS THERE ANY OBJECTION,6 

MR. YAROSLAVSKY? ALL RIGHT. AS AMENDED, VIOLET, SO THAT WE7 

WOULD ONLY SUPPORT IT IF IT IS A FULLY-FUNDED RESPONSIBILITY8 

TO THE COUNTY. OTHERWISE, WE WOULD OPPOSE IT. ALL RIGHT. IF9 

THERE -- MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY MYSELF,10 

AND IF THERE'S NO OBJECTION, SO ORDERED ON ITEM NUMBER 12, AS11 

AMENDED. DO YOU HAVE A QUESTION? OH, I'M SORRY, MR. WILLIAMS,12 

I APOLOGIZE. I'VE BEEN HOLDING IT HERE IN MY HAND. I'M SORRY.13 

MR. WILLIAMS WANTED TO ADDRESS US. PLEASE JOIN US. I14 

APOLOGIZE. I HAD IT RIGHT HERE ALL THE TIME I WAS...15 

16 

WARREN WILLIAMS: YES, I COULD SAY THIS TIME THAT WHAT USUALLY17 

HAPPENS ALREADY HAPPENED, YOU APPROVED IT ANYWAY.18 

19 

SUP. MOLINA: WELL, WE AMENDED IT.20 

21 

SUP. ANTONOVICH: MOVE FOR RECONSIDERATION.22 

23 
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SUP. MOLINA: BUT IF -- ABSOLUTELY. IT'S BEEN MOVED AND1 

SECONDED THAT WE RECONSIDER THE ITEM, IF THERE'S NO OBJECTION,2 

IT IS RECONSIDERED.3 

4 

WARREN WILLIAMS: THANK YOU.5 

6 

SUP. MOLINA: MR. WILLIAMS.7 

8 

WARREN WILLIAMS: REPRESENTATION OF THE FOUNDATION TO END9 

INSTITUTIONAL ABUSE IN OUR COMMUNITY AT LARGE, THERE ARE10 

SEVERAL CONCERNS THAT WE HAVE. I DID SUBMIT SOMETHING IN11 

WRITING TO EACH OF YOU ON THIS ITEM. THE FIRST THING IS THAT12 

WE DO OPPOSE IT. WE FEEL THAT IT LEADS TO SLASHING MORE13 

PARENTAL RIGHTS AND FREEDOMS. WE FEEL THAT JUVENILE COURT14 

CANNOT BE RELIABLE AS AN ENTITY TO DECIDE THESE TYPE OF15 

ISSUES. IT IS VERY BROAD AND GENERAL, THE ISSUES HAVE IN16 

JUVENILE COURT WRONG DEFINES ABUSE FREQUENTLY. THE TERMS, LONG17 

PERIODS OF BEING PREVENTED FROM ATTENDING SCHOOLS DEFINES18 

WHAT? A DAY? A WEEK? A MONTH? OR IS IT JUST AN EXCUSE FOR THE19 

SYSTEM TO GAIN WRONGFUL CONTROL OF FAMILIES. THE -- A LOT OF20 

TIMES WHEN PARENTS ARE WRONGLY SEPARATED FROM THEIR CHILDREN,21 

THEN THEY'RE INTO A BIND THAT THEY ARE NOT ALLOWED TO GO TO22 

THE SCHOOL, OR JUST MAY BAR US FROM GOING TO THE SCHOOL. I23 

BROUGHT TO YOU, BECAUSE I'VE BEEN CHALLENGED REPEATEDLY THAT24 

THERE'S NOT EVIDENCE OF CERTAIN THINGS, AND I GOT A BIG FOLDER25 
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OF MATERIAL THAT I'VE SUBMITTED BEFORE, BUT HERE'S A LETTER1 

FROM A LADY BY THE NAME OF PATRICIA JORDAN WHO VERIFIED IN MY2 

PERSONAL CASE OF MY BEING A GOOD PARENT AND A ROLE MODEL AT3 

THE SCHOOL. I ALSO HAVE HERE A COMMENDATION, A CERTIFICATE4 

THAT SHOWS THAT THE SCHOOL THAT MY SON WAS ATTENDING GAVE IT5 

TO ME FOR MY PARTICIPATION THERE AT THE SCHOOL. HERE IS AN6 

AWARD WHEN I'VE RUNG FROM SEPARATE FROM MY SONS SO THEN THE7 

COURT MADE IT HARD FOR ME TO BE GETTING BACK IN THE SCHOOL,8 

THAT MY SON WAS AWARDED A REWARD OF IMPROVEMENT, HE WAS THE9 

MOST IMPROVED STUDENT ONCE I GOT BACK INVOLVED. HERE'S AN10 

ORDER FROM THE STATE ADMINISTRATION THAT WAS ORDERING D.C.F.S.11 

TO ADDRESS MY CONCERNS ABOUT MY SON MISSING SCHOOL. THAT'S THE12 

CONCERN THAT I HAD AS A PARENT. HERE IS MY SON'S REPORT CARD13 

WITH THE TEACHER STATING THAT HE'S MISSING SCHOOL SO MUCH, IT14 

WAS AFFECTING HIS ABILITY TO LEARN, THEY FEEL HE COULD DO MUCH15 

BETTER 'CAUSE THE POTENTIAL WAS THERE. WHAT DID D.C.F.S. AND16 

THE JUVENILE COURT DO, THEY MADE ORDERS TO PREVENT ME FROM17 

BEING INVOLVED TO GO TO MY SON'S SCHOOLS. NOW, HERE WE'RE ALL18 

WITH A MAJOR BILL, A SENATE BILL 950 AND THE COUNTY'S SENDING19 

-- WRITE A LETTER TO SUPPORT THE SAME FLAWED SYSTEM D.C.F.S.20 

AND THE JUVENILE COURT TO AGAIN HARM FAMILIES, CHILDREN, AND21 

PARENTS, YOU KNOW, WITH THIS TYPE OF PROCESS. SO SHOULD IT BE22 

RECONSIDERED? IT DEFINITELY SHOULD BE RECONSIDERED. YOU SHOULD23 

NOT APPROVE THIS. AND AGAIN, I URGE YOU TO LOOK AT THE FACTS24 

THAT I SUBMITTED.25 
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1 

SUP. MOLINA: ALL RIGHT, THANK YOU, MR. WILLIAMS. MY ONLY2 

EXPERIENCE WITH THIS IS THAT I HAVE FOUND IT TO BE VERY3 

WORTHWHILE, THAT WHEN CHILDREN ARE TRUANT FROM SCHOOL, YOU4 

HAVE TO HOLD PARENTS ACCOUNTABLE, AND IT BEGINS WITH THAT, AND5 

IF THEY AREN'T GOING TO BE HELD ACCOUNTABLE, THEN IT'S OUR6 

RESPONSIBILITY TO MAKE SURE THAT THE CHILDREN ARE GETTING TO7 

SCHOOL, AND I THINK THAT THIS POLICY, WHILE IT'S A POLICY THAT8 

THE COUNTY ALREADY HAS, I THINK IT'S GOOD TO HAVE IT9 

REINFORCED BY THE STATE, BUT IT MUST HAVE THE PROPER FUNDING.10 

SO --11 

12 

SUP. YAROSLAVSKY: MADAM CHAIR?13 

14 

SUP. MOLINA: YES SIR?15 

16 

SUP. YAROSLAVSKY: I JUST WANT TO ASK, FIRST OF ALL, I'M17 

ADVISED THAT OUR DEPARTMENT OF CHILDREN AND FAMILY SERVICES --18 

19 

SUP. MOLINA: THEY MIGHT BE HERE. I'M NOT SURE. IS CHILDREN20 

SERVICES HERE?21 

22 

SUP. YAROSLAVSKY: AND I'M ADVISED THAT THEY DO NOT TAKE THE23 

SAME VIEW OF THIS, AND NEITHER --24 

25 
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SUP. MOLINA: RIGHT. THEY ARE BASICALLY ASKING US TO OPPOSE IT.1 

2 

SUP. YAROSLAVSKY: NEITHER DOES THE COUNTY WELFARE DIRECTOR'S3 

ASSOCIATION, WHICH OPPOSES IT. AND I WOULD JUST LIKE TO HEAR4 

THEIR ARGUMENTS.5 

6 

SUP. MOLINA: IS THERE SOMEONE HERE FROM THE CHILDREN'S7 

SERVICES?8 

9 

C.A.O. JANSSEN: YES. DR. SANDERS IS HERE.10 

11 

SUP. MOLINA: MR. SANDERS. WELCOME, SIR.12 

13 

DAVID SANDERS: THANK YOU.14 

15 

SUP. MOLINA: I DON'T KNOW IF YOU HAVE THE ANSWER TO OUR16 

QUESTION HERE.17 

18 

DAVID SANDERS: ACTUALLY I COULDN'T HEAR THE QUESTION I'M19 

SORRY.20 

21 

SUP. YAROSLAVSKY: WELL IT'S A QUESTION IS ON -- ON SB 950, THE22 

MOTION THAT MR. ANTONOVICH HAS BROUGHT IN TO SUPPORT IT, I23 

UNDERSTAND THAT YOUR DEPARTMENT IS NOT SUPPORTIVE OR IS EVEN24 

POSSIBLY IN OPPOSITION AND YOUR STAFF REPORT SAYS THAT THE25 
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CALIFORNIA -- THE COUNTY WELFARE DIRECTOR'S ASSOCIATION OF1 

CALIFORNIA HAS INDICATED AN OPPOSITION TO SB 950 OR THAT SUCH2 

A POSITION IS PENDING, AND I DON'T KNOW WHETHER YOU GOT A3 

CHANCE TO REVIEW THIS YOURSELF, WHETHER YOU'RE PREPARED TODAY4 

TO SPEAK TO THE DEPARTMENT'S POSITION ON THE BILL, AND IF SO,5 

WHAT IS YOUR POSITION?6 

7 

DAVID SANDERS: SUPERVISOR YAROSLAVSKY, I'M NOT PREPARED TO8 

SPEAK ON IT TODAY. I CAN CERTAINLY LOOK INTO IT.9 

10 

SUP. YAROSLAVSKY: I WOULD THEN MOVE THAT WE CONTINUE THIS ONE11 

WEEK AND GIVE MR. SANDERS A CHANCE TO GIVE US A PRESENTATION,12 

BECAUSE I'M INTERESTED IN WHAT YOU AND YOUR COLLEAGUES AROUND13 

THE STATE ARE SAYING ABOUT THIS.14 

15 

SUP. MOLINA: I DON'T HAVE A PROBLEM WITH A CONTINUANCE, BUT SO16 

THAT WE HAVE AN UNDERSTANDING, RIGHT NOW IN SOME OF OUR17 

DISTRICTS, AT LEAST I'VE IMPLEMENTED IT IN MY DISTRICT, AND I18 

DON'T KNOW THE JUR -- IN THIS LEGISLATION AS TO WHAT EXTENT19 

THE JURISDICTION OF THE JUVENILE COURTS WOULD BE INVOLVED IN20 

THIS, BUT RIGHT NOW, THE D.A. DOES PROSECUTE PARENTS WHO ARE -21 

- WHOSE CHILDREN ARE TRUANT, AND THAT DOESN'T HAPPEN22 

EVERYWHERE, THERE'S SPECIAL PROGRAMS THAT ARE PUT IN PLACE,23 

AND I THINK THAT WHAT THIS DOES, FOR THE MOST PART, IS IT24 

CREATES A STATEWIDE POLICY IN THAT REGARD, BUT IT'S PROBABLY25 
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BETTER TO GET A FULL CLARIFICATION. I READ THE CHILDREN'S --1 

THE DEPARTMENT OF CHILDREN SERVICES' OBJECTION AS TO BEING ONE2 

OF ADDITIONAL RESPONSIBILITIES WITHOUT ANY FUNDING, AND3 

UNFORTUNATELY, WHILE, AGAIN, THIS IS NOT A MINOR MATTER, AT4 

THE SAME TIME, THE DEPARTMENT OF CHILDREN SERVICES HAS SO MANY5 

OTHER MORE SEVERE ISSUES OTHER THAN SCHOOL TRUANCY THAT IT'S6 

SORT OF TOUGH TO NOW MAKE THEM THE WATCHDOGS OF THOSE KIDS7 

THAT ARE NOT ATTENDING SCHOOL AS WELL, SO I CAN UNDERSTAND8 

THOSE AREAS, BUT I THINK IF IT'S FULLY FUNDED, THERE MIGHT BE9 

AN OPPORTUNITY. BUT WITH THAT, LET'S CONTINUE THIS --10 

11 

SUP. YAROSLAVSKY: I'LL TELL YOU WHAT MY CONCERN IS ABOUT THIS,12 

BECAUSE THE WAY YOU DESCRIBED IT, IT MAY BE CONSISTENT WITH13 

WHAT THE BILL DOES, BUT AS I UNDERSTAND IT, THE BILL ADDS14 

HABITUAL TRUANCY TO THE LIST OF FACTORS, ACCORDING TO THE15 

D.C.F.S. REPORT, WHEREBY A CHILD MAY COME UNDER THE16 

JURISDICTION OF THE JUVENILE COURT. SO A KID WHO'S GOT A17 

TRUANCY PROBLEM COULD END UP BEING YANKED FROM THE PARENTS,18 

AND IF -- AND AS I UNDERSTAND IT, I WOULD JUST -- I DON'T19 

UNDERSTAND IT, I'M ASSUMING THAT ON THE OTHER FACTORS THAT A20 

CHILD CAN BE REMOVED FROM HIS PARENTS OR PARENT, PHYSICAL,21 

SEXUAL, EMOTIONAL ABUSE, EXPLOITATION AND NEGLECT. SO THEY CAN22 

-- THE AUTHORITIES CAN MAKE A CASE -- IF THE AUTHORITIES CAN23 

MAKE A CASE TODAY THAT NEGLECT IS THE REASON THAT THE CHILD IS24 

HABITUALLY TRUANT, THERE'S ENOUGH IN THE LAW TODAY TO GO AFTER25 
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THE PARENT. SO WHAT I'M TRYING TO UNDERSTAND IS, BY ADDING1 

HABITUAL TRUANCY IN ADDITION TO NEGLECT, IT'S ALMOST AS THOUGH2 

IF A KID IS HABITUALLY TRUANT, REGARDLESS OF THE ROLE OF THE3 

PARENT, THIS IS THE WAY IT SOUNDS TO ME, BECAUSE YOU'VE4 

ALREADY GOT NEGLECT IN THE LAW, THAT YOU COULD -- YOU COULD5 

HAVE THIS MASSIVE, I SHOULDN'T SAY "MASSIVE," BUT ANYBODY IN6 

THAT SITUATION COULD FIND THEMSELVES -- ANY CHILD IN THAT7 

SITUATION COULD FIND THEMSELVES YANKED OR POTENTIALLY YANKED8 

FROM THEIR PARENTS, EVEN THOUGH IT MAY NOT, BECAUSE OF THE9 

CIRCUMSTANCES, MAY NOT BE AN ISSUE OF NEGLECT, AND WE ALL KNOW10 

CASES WHERE THERE'S NEGLECT AND WE ALL KNOW CASES WHERE11 

THERE'S TRUANCY, WHERE IT'S NOT NECESSARILY NEGLECT, AT LEAST12 

NOT FOR A LIMITED PERIOD OF TIME. THAT'S THE QUESTION I HAVE,13 

IS NEGLECT IS ALREADY IN THERE.14 

15 

C.A.O. JANSSEN: THAT'S EXACTLY RIGHT, SUPERVISOR. THE CURRENT16 

PROCESS --17 

18 

SUP. YAROSLAVSKY: AND I DON'T HAVE ANY OBJECTION TO THE WAY19 

YOU DESCRIBED IT, HABITUAL --20 

21 

C.A.O. JANSSEN: YOU DESCRIBED IT CORRECTLY.22 

23 

SUP. YAROSLAVSKY: YOU KNOW, WHEN THE PARENT IS NEGLECT -- WHEN24 

IT'S THE PARENT'S FAULT, BY ALL MEANS, THE PARENTS GOT -- THE25 
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PARENT'S GOT TO BE HELD ACCOUNTABLE, BUT WHAT IF IT'S -- WHAT1 

IF THE HABITUAL TRUANCY IS NOT THE PARENTS' FAULT? AND, YOU2 

KNOW, TWO WORKING PARENTS OR THERE MAY NOT EVEN BE TWO3 

PARENTS, MAYBE THERE'S ONE PARENT, MAYBE IT'S AND THEY'RE4 

WORKING, THEY LIVE IN PALMDALE AND THEY'RE WORKING DOWNTOWN5 

AND, I MEAN, YOU KNOW, AND ALL THE SOCIAL PROBLEMS YOU'VE GOT6 

OUT IN THE ANTELOPE VALLEY THAT -- SO IT'S ALL -- ALL OF THIS7 

JUST, TO ME, I'D LIKE TO UNDERSTAND THIS BEFORE WE BECOME THE8 

FIRST ENTITY ON RECORD SUPPORTING THIS BILL WHICH IS RIGHT9 

NOW, ACCORDING TO YOUR REPORT, THERE IS NOBODY ELSE.10 

11 

SUP. MOLINA: AND MR. YAROSLAVSKY, IT MIGHT BE WORTHWHILE AS12 

WELL, AND MR. SANDERS, TO TALK TO THE D.A. AND THE PROGRAM13 

THAT THEY HAVE. WE HAVE FOUND, AT LEAST IN THE TRUANCY PROGRAM14 

THAT WE HAD, THAT YOU ALMOST -- THE PARENTS WILL NOT BE HELD -15 

- THEY DO EXACTLY THAT, "HEY, IT'S NOT MY FAULT, YOU KNOW, I16 

SEND HIM TO SCHOOL, IF HE DOESN'T GET THERE, THAT'S THE17 

SCHOOL'S PROBLEM," AND AGAIN, THE SCHOOLS CANNOT BE18 

RESPONSIBLE FOR CORRALLING CHILDREN THAT, YOU KNOW, ARE JUST19 

NOT GOING TO BE OBEDIENT, I MEAN THERE IS A RESPONSIBILITY AND20 

A DUTY FROM PARENTS. BUT I THINK THAT AGAIN, PROBABLY THOSE21 

ARE FACTORS THAT WE WANT TO TAKE INTO ACCOUNT. THE OTHER --22 

ONE OF THE OTHER AREAS THAT WE'RE EXPLORING AS WELL IN WHICH23 

CHILDREN CAN AND SHOULD BE TAKEN AWAY THAT ALSO FALLS UNDER24 

NEGLECT AND DANGER, BUT MAYBE SOMETIMES NEED TO BE SPECIFIED25 
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IS WHEN THERE IS A GANG PRESENCE IN A HOME AND THERE ARE GUNS,1 

MAKING AN AREA UNSAFE FOR CHILDREN AND THERE HAS BEEN, YOU2 

KNOW, IT'S AN ISSUE OF WHETHER, IN FACT, A D.A. IS GOING TO3 

MAKE THAT DETERMINATION AND THE DEPARTMENT'S GOING TO MAKE4 

THAT DETERMINATION OR NOT, BUT THERE IS JUSTIFICATION FOR THE5 

SAFETY OF THE CHILD, BUT I THINK IT IS WORTHWHILE TO GET FULL6 

CLARIFICATION, NOT JUST BECAUSE THE CHILDREN WELFARE DIRECTORS7 

ARE OPPOSED TO IT, I DON'T KNOW THAT THEY KNOW THE EXTENT OF8 

IT. I KNOW THAT NO ONE ELSE WANTS MORE WORK IN THIS WHOLE9 

AREA, BUT AGAIN, TRUANCY IS THE BEGINNING OF A BIGGER PROBLEM10 

WITH THAT CHILD. SO IF YOU HAVE A TRUANT KID IN SIXTH GRADE,11 

YOU'RE GOING TO HAVE A KID ON HIS WAY TO A WHOLE LOT OF12 

PROBLEMS ALONG THE WAY, AND WE CANNOT BE THE WARDS OF13 

EVERYBODY, BUT AT THE SAME TIME, IF WE DON'T STARTING HOLDING14 

PARENTS ACCOUNTABLE AND START THAT PROCESS EARLY ENOUGH, THESE15 

CHILDREN END UP OUR WARDS ANYWAY, AND EITHER IN OUR JUVENILE16 

COURT SYSTEM OR IN OUR CHILDREN SERVICES DEPARTMENT, SO I17 

THINK THAT WE NEED TO LOOK AT THOSE ISSUES. BUT WE'LL CONTINUE18 

THIS ITEM. IS IT FOR ONE WEEK OR TWO WEEKS? MR. SANDERS, WOULD19 

YOU BE BETTER OFF IN TWO WEEKS? I DON'T THINK THERE WILL BE A20 

LOT OF LEGISLATIVE MOVEMENT ANYWAY.21 

22 

SUP. YAROSLAVSKY: THEY'RE NOT AROUND, YEAH. TWO WEEKS THEN,23 

I'LL MAKE IT TWO WEEKS.24 

25 
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SUP. MOLINA: TWO WEEKS. ALL RIGHT.1 

2 

C.A.O. JANSSEN: AND WE'LL FOLLOW UP WITH THE CHIEF PROBATION3 

OFFICER AND D.A. ON THE CURRENT TRUANCY MEDIATION PROGRAM THAT4 

EXISTS.5 

6 

SUP. MOLINA: RIGHT, I THINK IT'D BE WORTHWHILE TO SHARE WITH7 

THEM WHAT THEIR ACTIONS HAVE BEEN IN THAT REGARD. VERY GOOD.8 

THANK YOU SO MUCH, SIR. ALL RIGHT, SO WE'LL CONTINUE THAT ITEM9 

AND THEN THE FINAL ITEM THAT I HAVE IS ITEM NUMBER 22. THIS IS10 

THE ITEM THAT WE ARE GOING TO CONTINUE. I HAVE THE QUESTIONS11 

OF THE C.A.O. -- C.I.O., EXCUSE ME, BECAUSE OF THE12 

DELIVERABLES THAT WE HAD ASKED FOR LAST TIME WITH REGARD TO13 

THIS CONSULTANT. I AM STILL, AS PROBABLY YOU WELL KNOW, HAVE14 

RESERVATIONS MOST OF THE TIME AS TO HOW WE PROCEED ON SOME OF15 

THESE COMPUTER PROGRAMS. THIS ONE HAS BEEN OF PARTICULAR16 

CONCERN TO ME. AT THE SAME TIME, I DO KNOW THAT WE HAVE TO PUT17 

SYSTEMS IN PLACE THAT ARE GOING TO ASSURE US THE KIND OF18 

SAFETY SHOULD WE BE OVERWHELMED BY SOME KIND OF TERRORISM19 

ATTACK OR THINGS OF THAT SORT. SO IF YOU DON'T MIND, I THINK20 

THAT MY STAFF MIGHT HAVE THE AMENDMENTS AVAILABLE THAT I'D21 

LIKE TO ASK THAT WE DO. I'M GOING TO DO ASK MR. FULLINWIDER IF22 

YOU'D ACCEPT AN AMENDMENT THAT WOULD INCLUDE THAT THE23 

CONSULTANT REPORT INCLUDE A RANGE OF OPTIONS OF COST IF24 

MINIMAL SAFEGUARDS ARE IMPLEMENTED AND IF MAXIMUM SAFEGUARDS25 
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ARE PUT IN PLACE. IN OTHER WORDS, IF WE SPEND X AMOUNT OF1 

DOLLARS, HOW MUCH PREPAREDNESS IS THE COUNTY GETTING. I THINK2 

IT'S IMPORTANT FOR US TO UNDERSTAND THE TANGIBLE ASPECTS OF3 

SOME OF THESE CONSULTANT AWARDS, AND IT'S BETTER TO KNOW WHAT4 

WE'RE GETTING INTO. I'D LIKE THE BOARD TO SCHEDULE A SET ITEM5 

IN WHICH THE C.I.O. WOULD REPORT BACK ON HOW THE EXPENDITURE6 

OF THE WHOLE 400,000 WAS UTILIZED, BECAUSE IT DOES -- THE7 

DELIVERABLES ARE TRAINING, THE DELIVERABLES ARE INTERACTION OR8 

INTERFACING WITH THE DEPARTMENT AS TO HOW THE SYSTEM IS GOING9 

TO BE CONNECTED TO THE SOFTWARE AND THE SYSTEM THAT WE'RE10 

GOING TO BE PUTTING IN PLACE. AND FINALLY, THE C.I.O., IN11 

COLLABORATION WITH THE AUDITOR-CONTROLLER AND THE C.A.O., IF12 

THEY COULD PROVIDE MONTHLY ASSESSMENTS ON THE DELIVERABLES OF13 

PROGRAMS AND COSTS, MONTHLY REPORTS SHOULD OUTLINE COST14 

FACTORS ASSOCIATED WITH IMPLEMENTATION, UPDATES ON PROGRESS15 

AND TIMELINESS FOR COMPLETION OF EACH PHASE OF THE PROJECT.16 

THE REASON I ASK FOR MONTHLY, AND YOU MIGHT WANT TO ASK FOR A17 

DIFFERENT TIME FRAME, LIKE QUARTERLY --18 

19 

SPEAKER: YES, QUARTERLY.20 

21 

SUP. MOLINA: QUARTERLY? THAT'S FAIR. ONLY BECAUSE THIS IS NOT22 

A GREAT TIME TO BE SPENDING MONEY ON COMPUTER SYSTEMS,23 

CONSIDERING OUR BUDGET. BUT I UNDERSTAND HOW IMPORTANT AND24 

SIGNIFICANT THIS IS. BUT STAYING ON BUDGET FOR AN ITEM LIKE25 
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THIS IS EQUALLY AS IMPORTANT IN GETTING TO GOAL. SO IF YOU1 

WOULDN'T MIND THOSE THREE AMENDMENTS, I WOULD ACCEPT THIS ITEM2 

WITH THOSE AMENDMENTS.3 

4 

SPEAKER: THE RECOMMENDATIONS YOU HAVE MADE, SUPERVISOR, ARE5 

CERTAINLY FINE WITH US.6 

7 

SUP. MOLINA: ALL RIGHT. I WOULD LEAVE THAT TO THE C.I.O. THE8 

QUESTION WAS, WHEN WOULD WE SET THIS ITEM FOR A -- MR.9 

FULLINWIDER, THE QUESTION WAS WHEN WE WOULD SET THIS ITEM FOR10 

A BOARD REPORT? I WOULD LEAVE THAT TO YOU TO SET IT WHEN IT'S11 

READY TO COME BACK TO THE BOARD.12 

13 

JON FULLINWIDER: THAT WOULD BE FINE.14 

15 

SUP. MOLINA: OKAY. IS THERE ANY OTHER QUESTION OR COMMENT FROM16 

THE BOARD MEMBERS ON THIS ITEM? IF NOT, AS AMENDED BY MYSELF,17 

SECONDED BY SUPERVISOR YAROSLAVSKY -- DID YOU HAVE A QUESTION,18 

DAVID?19 

20 

C.A.O. JANSSEN: NO, I'M TO FINISH.21 

22 

SUP. MOLINA: OKAY, IF THERE'S NO OBJECTION, SO ORDERED ON THAT23 

ITEM.24 

25 
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C.A.O. JANSSEN: I THOUGHT AS LONG AS JON IS HERE, HE MIGHT DO1 

JUST TWO MINUTES ON H.I.P.A.A., BECAUSE THE LATEST COMPLIANCE2 

REPORT IS OUT ON WHERE WE ARE ON H.I.P.A.A. COMPLIANCE, AND3 

IT'S A GOOD REPORT. HE MIGHT JUST MENTION WHERE WE ARE.4 

5 

SUP. MOLINA: SURE. THAT'D BE GREAT.6 

7 

JON FULLINWIDER: GREAT, THANK YOU VERY MUCH. FOR THE RECORD MY8 

NAME'S JON FULLINWIDER, I'M THE COUNTY'S CHIEF INFORMATION9 

OFFICER. WITH REGARD TO H.I.P.A.A., WE, ON APRIL 14TH, WE10 

ARRIVED AT A MAJOR MILESTONE THAT WOULD SUGGEST THAT WE HAD TO11 

HAVE ALL OUR HEALTHCARE WORKERS TRAINED IN H.I.P.A.A.12 

COMPLIANCE AS IT RELATES TO PRIVACY TRAINING. I'M HERE TO TELL13 

YOU THAT ALL THE DEPARTMENTS INVOLVED, HEALTH, MENTAL HEALTH,14 

AND THE KIRBY CENTER, THE PROBATION DEPARTMENT EXCEEDED THEIR15 

GOALS OF OVER 85 PERCENT. THERE ARE ABOUT 3,000 PEOPLE THAT16 

ARE STILL REQUIRED TO BE TRAINED. THOSE PEOPLE HAVE BEEN17 

IDENTIFIED AND WILL BE TRAINED WITHIN THE NEXT 30 DAYS, BUT AT18 

THIS POINT IN TIME, WE ARE SUBSTANTIALLY COMPLIANT FAR IN19 

EXCESS OF ANY OF OUR BRETHREN COUNTIES IN THIS STATE, AND I20 

THINK THE DEPARTMENTS ARE TO BE COMPLIMENTED, THEY DID AN21 

OUTSTANDING JOB IN A VERY SHORT PERIOD OF TIME TO PULL THIS22 

OFF, AND I APPRECIATE THE SUPPORT THAT THE BOARD PROVIDED IN23 

MAKING THIS A PRIORITY WITHIN THE COUNTY.24 

25 
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SUP. MOLINA: WELL, CONGRATULATIONS. I THINK IT WAS A SIMPLE1 

PROCESS THAT SHOULD HAVE BEEN EMBRACED MUCH EARLIER IN THE2 

PROCESS, BUT I'M GLAD THEY FINALLY DID DO IT. AND THIS3 

H.I.P.A.A. COMPLIANCE, IT'S JUST -- IT'S GOING TO BE A4 

STRUGGLE FOR EVERYBODY, IN THE PRIVATE SECTOR AS WELL AS IN5 

THE PUBLIC SECTOR.6 

7 

JON FULLINWIDER: THAT'S CORRECT.8 

9 

SUP. MOLINA: BUT THE REALITY IS IT'S A FEDERAL MANDATE,10 

FEDERAL RESPONSIBILITIES AND WE NEED TO STAY ON TARGET, SO I11 

APPRECIATE YOU MONITORING THAT ALL THE WAY THROUGH. GOOD. ANY12 

QUESTION OR COMMENT? IF NOT, THANK YOU SO MUCH ON THAT ITEM.13 

THAT COMPLETES MY ITEMS. I TURN IT OVER TO SUPERVISOR14 

YAROSLAVSKY FOR ANY ADJOURNMENTS OR SPECIAL ITEMS.15 

16 

SUP. YAROSLAVSKY: MADAM CHAIR, I'D LIKE TO ASK THAT, I DO HAVE17 

AN ADJOURNING MOTION, THAT WE ADJOURN IN THE MEMORY OF NELLY18 

GUTEGNO, WHO'S A RESIDENT OF LOS ANGELES COUNTY, PASSED AWAY19 

AT THE AGE OF 75 AFTER A LONG STRUGGLE WITH PARKINSON'S20 

DISEASE. SHE IS THE MOTHER OF LINDA GUTEGNO BURGOFF, AND THE21 

MOTHER-IN-LAW OF ARNOLD BURGOFF, I THINK WHO WE ALL KNOW AND22 

SO WE ADJOURN IN HER MEMORY, AND THAT'S THE ONLY ADJOURNING23 

MEASURE --24 

25 
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SUP. MOLINA: SO ORDERED.1 

2 

SUP. YAROSLAVSKY: THAT -- THE ONLY ADJOURNING MOTION I HAVE. I3 

DON'T THINK I'M HOLDING ANYTHING.4 

5 

SUP. MOLINA: NO, YOU DON'T HAVE ANY MOTIONS THAT YOU HELD. ALL6 

RIGHT. SUPERVISOR ANTONOVICH?7 

8 

SUP. ANTONOVICH: LET ME JUST -- A COUPLE OF THESE WERE DONE9 

LAST WEEK WHEN I WAS IN WASHINGTON, BUT JUST TO ONCE AGAIN,10 

DR. WAHI SHINDI, WHO WAS A FORMER MEMBER OF MOBARAK'S CABINET11 

IN EGYPT, FOR ECONOMIC DEVELOPMENT, WHO PASSED AWAY12 

UNEXPECTEDLY AFTER LEAVING LOS ANGELES, WHERE HE WAS VISITING13 

HIS BROTHER'S FAMILY AND AUNTS, NIECES, AND NEPHEWS. HE DIED14 

OF A HEART ATTACK. HE WAS A VERY WONDERFUL INDIVIDUAL WHO HAD15 

A GREAT VISION AND WAS A REAL LOSS, AND ALSO MICHAEL WAYNE,16 

WHO WAS ONE OF THE TOP PRODUCERS IN HOLLYWOOD, STARTING AT A17 

VERY YOUNG AGE, PRODUCING MANY OF HIS FATHER'S FILMS. MICHAEL18 

WAS ALSO A SUPPORTER AND FRIEND WHO UNEXPECTEDLY PASSED AWAY.19 

AND RANDALL SMITH, ONE OF THE ETHICAL CONSULTANTS IN POLITICS20 

WHO PASSED AWAY AT A VERY YOUNG AGE OF 55, WHO LEFT HIS WIFE,21 

JEAN, AND THREE CHILDREN. AND DAVID BLOOM, THE REPORTER WHO22 

PASSED AWAY IN IRAQ. DAVID KIND OF CUT HIS TEETH HERE IN LOS23 

ANGELES ON THE O.J. TRIAL, WHERE HE WAS A REGULAR HERE24 

VISITING WITH US AND INTERVIEWING US DURING THAT TRIAL. A VERY25 
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PROFESSIONAL, ETHICAL INDIVIDUAL, WHO WAS A CREDIT TO HONEST1 

REPORTING. AND TO JANETTE DRAKES BOIAGIAN, WHO WAS ONE OF MY2 

FIRST SUPPORTERS WHEN I RAN FOR PUBLIC OFFICE, WHO PASSED3 

AWAY. AND SHE LEAVES HER HUSBAND, DR. JERRY BOIAGIAN AND FOUR4 

CHILDREN. TODAY I WOULD LIKE TO MOVE ALSO IN MEMORY OF CELESTE5 

KING, WHO PASSED AWAY. CELESTE KING WAS A PERSONAL FRIEND AND6 

QUITE INVOLVED IN REPUBLICAN PARTY POLITICS, A STRONG7 

SUPPORTER OF THE BUSHES AND RONALD REAGAN, GOING BACK WITH8 

GEORGE DEMACHIAN. AND HE AND HIS WIFE, ANITA, WERE A VERY9 

CLASS ACT. THEY'VE TRAVELED ALL OVER THIS STATE ON POLITICAL10 

ISSUES AND INVOLVED IN THEIR COMMUNITY AND HE TOOK THE11 

LEADERSHIP IN THE CONGRESS AND RACIAL EQUALITY AND WAS A GREAT12 

SPOKESMAN. HE HAD BEEN BEFORE THE BOARD MANY TIMES RECEIVING13 

RECOGNITION AND CONTINUING HIS SERVICE, NOT JUST IN THE14 

COMMUNITY, BUT ALSO HIS MILITARY SERVICE IN THE RESERVES AND15 

WAS A REAL POSITIVE ROLE MODEL FOR OUR COMMUNITY AND A LOSS.16 

AND OUR BEST GOES TO ANITA AND HER FAMILY AND HIS THREE17 

CHILDREN. ALSO MOVE IN MEMORY OF ANNETTE SUKING ARR, THE WIFE18 

OF DR. WAYMAN ARR. SHE PASSED AWAY ON APRIL 9TH. ONE OF HER19 

CHILDREN IS MARY ARR, WHO WAS A FORMER MEMBER OF THE CHURCH I20 

ATTENDED. JEAN BURKE, A LONG-TIME SANTA CLARITA RESIDENT,21 

FOUNDING DIRECTOR OF THE VALENCIA NATIONAL BANK, BOARD MEMBER22 

FOR THE COLLEGE OF THE CANYONS FOUNDATION, WHO AWARDED HIM THE23 

DESIGNATION OF BOARD MEMBER EMERITUS, VOLUNTEER FOR THE SANTA24 

CLARITA VALLEY SHERIFF'S POSSE, ACTIVE WITH THE SANTA CLARITA25 
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VALLEY BOYS AND GIRLS CLUB, AND THE SENIORS CENTER AND HENRY1 

MAYO NEWHALL HOSPITAL. FRANK DELMAR, WHO WAS THE FATHER OF A2 

FORMER DEPUTY OF MINE, KERRY DELMAR, WHO PASSED AWAY. AND3 

THOSE ARE MY ADJOURNMENTS.4 

5 

SUP. MOLINA: OKAY, SO ORDERED ON THOSE ADJOURNMENTS. THE6 

CELESTE KING MOTION WAS BROUGHT IN BY SUPERVISOR BURKE.7 

8 

SUP. ANTONOVICH: I'M AWARE OF THAT.9 

10 

SUP. MOLINA: AND SUPERVISOR KNABE, AND I THINK WE'D LIKE TO11 

HAVE ALL MEMBERS ON -- ON DAVID BLOOM.12 

13 

SUP. ANTONOVICH: RIGHT. AND I HAVE TWO -- RIGHT WE DID THAT14 

LAST WEEK --15 

16 

SUP. YAROSLAVSKY: WE DID THAT LAST WEEK.17 

18 

SUP. ANTONOVICH: WE DID THAT LAST WEEK, I JUST WANTED -- WHEN19 

I WAS IN WASHINGTON. THIS IS IF WE COULD HAVE A REPORT BY THE20 

STATE -- I SHOULD SAY BY THE DIRECTOR OF PUBLIC WORKS IN21 

REGARDS TO A RECENT REPORT PREPARED BY THE STATE REGIONAL22 

WATER QUALITY BOARD WHICH THEY RAISED CONCERNS OVER POTENTIAL23 

GROUNDWATER CONTAMINATION UNDER THE SUNSHINE CANYON LANDFILL.24 

AND I'D ASK THAT WE DIRECT THE DIRECTOR OF PUBLIC WORKS TO25 
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REVIEW THE REPORT AND REPORT BACK TO THE BOARD WITHIN 30 DAYS1 

WITH HIS FINDINGS ON THAT REPORT AND ASK THAT WE COULD APPROVE2 

THAT TODAY BECAUSE IT'S ASKING FOR A REPORT.3 

4 

SUP. MOLINA: ALL RIGHT, ANY OBJECTION? IT'S JUST A REPORT?5 

6 

SUP. ANTONOVICH: AND I HAVE ANOTHER MOTION CO-AUTHORED BY7 

SUPERVISOR YAROSLAVSKY. CERTAIN STRETCHES OF THE L.A. FREEWAY8 

SYSTEM, SUCH AS THE 101-405 INTERCHANGE ARE IN GRIDLOCK,9 

SENATOR TOM MCCLINTOCK HAS PROPOSED SENATE BILL 957 PERMITTING10 

THE GOVERNOR TO CUT THE RED TAPE, EXPEDITING THE CONSTRUCTION11 

WITH ANY STRETCH OF FREEWAY THAT HAS REACHED 3,000 HOURS OF12 

DELAY PER DAY. AFTER THE NORTHRIDGE EARTHQUAKE, IT TOOK ONLY13 

66 DAYS TO REPAIR THE 10 FREEWAY IN SANTA MONICA, THAT OUGHT14 

TO BE THE MODEL FOR ALL CONSTRUCTION WORK ON THE FREEWAY WHEN15 

THE ALTERNATIVE IS TO RESIGN OURSELVES TO YEARS OF DELAYED16 

CONSTRUCTION, GRIDLOCK, AND ADDITIONAL AIR POLLUTION. AND THIS17 

WOULD BE TO SEND A 5-SIGNATURE LETTER URGING SUPPORT OF THAT18 

GRIDLOCK -- ENDING THAT GRIDLOCK AT THE 101-405 INTERCHANGE AS19 

WELL AS OTHER CHOKE POINTS IN OUR FREEWAY SYSTEM TO THE20 

GOVERNOR AND THE LEGISLATURE.21 

22 

SUP. MOLINA: ALL RIGHT. THAT'S FOR NEXT WEEK.23 

24 
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SUP. ANTONOVICH: THAT'D BE FOR NEXT WEEK BECAUSE IT'S NOT A1 

REPORT. THAT'S ALL I HAVE.2 

3 

SUP. MOLINA: ALL RIGHT. LET'S SEE. WE HAVE ITEM NUMBER 24,4 

WHICH HAS BEEN HELD BY MR. ROBINSON. MR. ROBINSON, IF YOU'D5 

JOIN US, PLEASE.6 

7 

RICHARD ROBINSON: MADAM CHAIR WOMAN AND MEMBERS, RICHARD8 

ROBINSON, NEIGHBORHOOD ORGANIZER IN ZEV'S DISTRICT. STRATEGIES9 

LIKE THIS SUPERVISOR KNABE'S VISION HAS BROUGHT -- MA'AM ARE10 

GOING TO WORK TO STOP GANG VIOLENCE. ONE BLOCK SOUTH OF THE11 

ENTERTAINMENT CENTER AT HOLLYWOOD AND HIGHLAND ACROSS THE12 

STREET FROM HOLLYWOOD HIGH SCHOOL, A CHILD WAS SHOT. IN13 

APPROVING THIS MATTER, YOU BRING MUTUAL AGREEMENT BETWEEN THE14 

COUNTY AND THE CITY AND HELP INDIVIDUALS LIKE MR. AND MRS. YU,15 

A TAIWANESE FAMILY WHO OWN MY RESIDENCE. DRUGS IN THAT16 

RESIDENTIAL NEIGHBORHOOD WILL BE PROLIFERATING, AS SHERIFF17 

BACA HAS TO POLICE A POTPOURRI OF ILLEGAL DRUGS BEING18 

ATTRACTED TO THAT NEIGHBORHOOD JUST TWO BLOCKS FROM THE19 

ENTERTAINMENT CENTER. I SENSE THAT SAGE WILL PROVIDE THE20 

NECESSARY POLICING OF GANGS AS HE RELEASES HUNDREDS OF21 

CRIMINALS BACK ON TO THE COUNTY STREETS. STRATEGIES AGAINST22 

GANG ENVIRONMENT WILL HELP THE POLICE. THOSE WHO HAVE BEEN23 

NEGLECTED AND WHO SEEK IDENTIFICATION THROUGH GANGS,24 

SUPERVISOR KNABE'S RECOMMENDATION WILL HELP. MR. AND MRS. YU25 
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MAINTAIN A SAFE ENVIRONMENT. S.A.G.E. WILL HELP THEM TO BE THE1 

SUCCESSFUL ENTREPRENEURS THEY CAN BE IF THEY DON'T HAVE TO BE2 

CONCERNED ABOUT THEIR LIVES, THE SAFETY OF THE FAMILY BEING3 

PURSUED BY, WILL HELP THEM TO THE -- CELESTE KING SAID IN CITY4 

COUNCIL CHAMBERS TO ME YEARS AGO, IN ECHOING FORMER CITY5 

COUNCILMAN GILL LINDSAY'S, "DON'T MOVE, IMPROVE." QUOTE,6 

UNQUOTE. ENABLING THIS LEGISLATION WILL NOT ONLY -- WELL, I7 

DON'T WANT TO BE TOO SPECIOUS HERE, BUT IT WILL NOT ONLY HELP8 

THE POLICE POLICE THE GANGS IN THE COUNTY, IT WILL ALSO HELP9 

ME KEEP THAT WONDERFUL TAIWANESE FAMILY FROM GOING BACK TO --10 

JUST GIVING UP AND GOING BACK TO TAIWAN BECAUSE IT FEELS IT11 

HAS NO SAFETY. THANK YOU.12 

13 

SUP. MOLINA: THANK YOU, MR. ROBINSON. ALL RIGHT. THAT WAS THE14 

LAST TIME THAT WE HAD. MOVED BY SUPERVISOR YAROSLAVSKY,15 

SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION --16 

17 

SUP. ANTONOVICH: I JUST HAD A COUPLE MORE ADJOURNMENTS.18 

19 

SUP. MOLINA: I'M SORRY?20 

21 

SUP. ANTONOVICH: JUST A COUPLE MORE ADJOURNMENTS.22 

23 

SUP. MOLINA: SURE.24 

25 
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SUP. ANTONOVICH: OKAY, ROBERT BOB MARLEY, HE WAS LONG TIME1 

ACTIVE IN THE SANTA CLARITA VALLEY -- I SHOULD SAY THE LA2 

CRESCENTA VALLEY BEFORE MOVING TO BANNING. LEOLA -- LOLA3 

PITTMAN, AN EMPLOYEE WITH THE LOS ANGELES COUNTY SHERIFF'S4 

DEPARTMENT. ANTONIO ROSCON, A 52-YEAR-OLD SERGEANT WITH THE5 

L.A. COUNTY SHERIFF'S DEPARTMENT, PASSED AWAY, AND ANDY6 

VAUGHN, A SIX-YEAR VETERAN OF THE SANTA CLARITA VALLEY'S7 

SHERIFF'S STATION WHO PASSED AWAY ON APRIL 12TH AFTER A THREE-8 

YEAR BATTLE WITH THE LOU GEHRIG'S DISEASE.9 

10 

SUP. MOLINA: ALL RIGHT, SO ORDERED ON THOSE ADJOURNMENTS. ANY11 

OTHERS MR. ANTONOVICH? ALL RIGHT. I UNDERSTAND WE HAVE NO12 

PUBLIC COMMENT. WE HAVE NO CLOSED SESSION TODAY, SO THERE ARE13 

NO OTHER ITEMS TO COME BEFORE THIS BOARD, WE STAND ADJOURNED.14 

THANK YOU SO MUCH.15 

16 


